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   Meloidogyne incognita   genome overview  

In  this  workshop,  you  will  learn  about  data,  tools  and  searches  the  consortium used  to 
annotate and analyze the M. incognita genome. 

The Aims of this workshop are to familiarise yourself with M. incognita genome annotation 
tools and to learn how to validate and/or correct protein-coding gene automatic annotations so 
you will be able to participate to  M. incognita genomic valorisation in the purpose of your 
research.

1.1.Automatic annotation

To start the workshop, here is an overview of the annotation pipeline that has been design for 
automatic structural and functional annotation of  M. incognita genome. This work has been 
done by bioinformatics teams from INRA Sophia Antipolis and INRA Toulouse.

Contacts:
Emeline Deleury (INRA Sophia Antipolis) and Jérôme Gouzy (INRA Toulouse)

1.1.1. Automatic annotation pipeline overview

Gene model predictions were produced using the integrative gene prediction platform EuGene 
(Figure  1).  To  evaluate  the  accuracy  of  the  produced  automatic  predictions,  a  reference 
dataset  of  230  M. incognita protein-coding gene models  was built  from EST libraries  by 
isolating full-length cDNA. After manual curation, all the gene model structures retained in 
the  reference  set  are  supported  by  the  alignment  of  their  genomic  sequence  with  the 
corresponding full-length transcript sequence. 

Statistical models of DNA composition (Interpolated Markov Models) for M. incognita were 
trained  using similarities  with  SwissProt and  Wormpep databases  and spliced  alignments. 
Regions intersecting the reference dataset  were removed. The EuGene combiner was then 
used to build a consensus annotation integrating both the statistical models and the evidence 
below:

• Translation starts and splice site predictions provided by the SpliceMachine software. 
Splice site models were trained on M. incognita using sites from spliced alignments of 
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genomic  contigs  to  ESTs  of  M.  incognita, produced  using  Genomethreader. 
Translation  start  models  were trained  using regions  of high similarity  with the N-
terminal region of SwissProt and Wormpep proteins. Sites appearing in the reference 
dataset were removed from the training set.

• Spliced  alignments  of  M.  incognita ESTs  and  corresponding  tentative  consensus 
aligned using Genomethreader.

• Protein similarities with the curated protein database SwissProt (Nov 2007) and the 
reference database Wormpep (release 180, Oct 2007) detected using NCBI-BLASTX.

• Sequence conservation with available nematode genomes (C. remanei, C. briggsae, C. 
elegans, B. malayi) computed using NCBI-TBLASTX.

• Alignments of nematode EST sequences (excluding M. incognita ESTs) produced by 
NCBI-TBLASTX.

• Repeats identified by  RepeatMasker searches against Repbase and the  M. incognita 
repeat database were used for soft masking to prevent the prediction of gene models 
matching transposable element sequences.

Splice  variants  were predicted  each time EST/mRNA evidence  of  different  isoforms  was 
observed (inconsistent splicing pattern in different spliced transcripts), each predicted isoform 
being constrained to follow one of the splicing patterns observed. 

Figure 1: Pipeline overview of the automatic structural annotation
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▪ M. incognita EuGene evaluation

In a first step, the accuracy of the pipeline was assessed on the 230 gene models from the built 
reference dataset (Figure 2). Genes and exons are considered as correctly predicted when all 
coordinates are precisely identified. Depending on the different types of evidence supporting 
the predicted gene model, the accuracy at the level of complete gene structure ranged from 
57% sensitivity in the absence of any similarity to 73.5% when the locus was supported by 
ESTs, protein similarities and other sequences conservations. Similarly, the exon sensitivity 
ranged from 73.2% to 89.3%.

Figure 2: Performance of the Eugene gene prediction pipeline against the references models.
Sn  and Sp G/E/N stands for Gene/Exon and Nucleotide level sensitivities and specificities 
respectively.  The TBX, BX and EST tags indicate the type of evidence integrated for the 
prediction  (TBX  stands  for  NCBI-TBLASTX,  BX  for  NCBI-BLASTX  and  EST  for 
GenomeThreader EST spliced alignments). 

▪ Data management and visualization 

Results of structural annotation as well as results for similarity of the  M. incognita contigs 
against  EST, WormPep, SwissProt, nematode genomes and nemotode mRNAs (other than 
Meloidogyne) were loaded into the chado database. 
Chado database is part of a collection of open source software tools for creating and managing 
genome-scale  biological  databases  called:  Generic  Model  Organism  Database  project. 
GMOD tools have been previously used for genome project on model organisms such as C. 
elegans (Wormbase). 

You can access the  chado database  via  2 genome browsers:  Gbrowse (Genome Browser – 
Paragraph 1.2.4.) and Apollo (annotation platform – Paragraph 1.3.). These 2 applications are 
used to navigate on the contigs and visualize the results at different scales.
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1.1.2. Automatic structural annotation

Using  reciprocal  best  blast  hit  approaches,  we  found  1,473  clusters  of  M.  incognita 
homologous  genes,  containing 6,068 predicted  genes and spanning about  54Mb. We then 
aligned  all  paired  supercontigs  at  the  nucleotide  level.  The  observed  similarities  and 
substitution rates confirmed the extensive shared homolog content between 648 supercontigs. 
This procedure could not assign any allelic relationship between small supercontigs, as they 
do not  contain  sufficient  information  to  construct  clusters.  We estimate  that  most of  the 
genome  is  present  as  two  highly  diverged  haplotypes,  as  all  large  supercontigs  were 
included in the list of 648 cases, with only two exceptions. These were checked and found to 
be  gene-poor  and  repetitive  elements-rich.  This  could  be  explained  by  the  difficulty  in 
aligning  single-copy  sequences  in  such  regions,  or  by  the  difficulty  in  assembling  them 
correctly. All other supercontigs could not be assigned a clear allelic relative due essentially 
to their small sizes. 

We found about 3.35 Mb of the assembly that corresponded to a third copy aligning with two 
previously identified allelic supercontigs. By analysing the unassembled reads, we estimated 
that  2.4  Mb of  haploid  genome  sequence may  represent  a  third  copy of  some  sequence 
segments in addition to the 3.35 Mb previously identified in the supercontigs. So, the total 
size of the genome that displays a third allelic version may be estimated as 3.35 + 2.4 = 5.75 
Mb, or about 11.5% of genome size, if we estimate the haploid genome as being 50 Mb.

▪ M. incognita general features and comparative content

A total of 20,359 gene models have been detected in the genome of M. incognita leading to a 
number of 19,212 distinct loci (the difference being attributed to splice variants). Table below 
summarizes automatic structural annotation results. 

Features M. incognita B. malayi C. elegans
Overall

Estimated size of genome (Mb) 47-51* 90-95* 100*

Total size of assembled sequence (Mb) 86 88 100
Number of scaffolds / chromosomes 2,817 8,180 6 chr.

N50 of scaffolds (kb) 82.8 93.8

Entirely 
sequenced

Maximum length of scaffold (bp) 593,295 6,534,162
Number of bp assembled into scaffolds 86,079,672 70,837,048

Number of orphan contigs / 18,868
Number of bp assembled into orphan contigs / 17,526,009
Number of singletons (Mi : unplaced reads) 267,656 176,099

Number of bp in singletons 164,646,515 108,289,205

Protein-coding regions
Percent of genome containing protein-coding sequence (%) 25.32 17.84 25.55c

Number of gene models 19,212 11,515a 20,072b

Number of proteins 20,365 11,508a 23,541 b

Max/average protein length (amino acids) 5,970/354 9,445/371 18,563/440
Gene density (genes per Mb) 223 162 228

Number of exons 127,119 83,672 146,294b

Mean/median exon size (bp) 169/136 159/140 307/147
Mean/median number of exons per gene 6.62/5 7.27/5 6.38/6

Number of bp included in exons 21,776,820 13,282,846 31,498,196b

Number of introns 109,181 72,157 138,596b

Mean/median intron size (bp) 230/82 311/219 320/68
Number of bp included in introns 25,081,026 22,512,502 35,536,104b

Mean length of intergenic region (bp) 1,402 3,783 2,218
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Overall G + C content (%) 31.4 30.5 35.4
Exons, G + C content (%) 35.5 39.6 42.9
Introns, G + C content (%) 29.2 27.6 29.1

Intergenic regions, G + C content (%) 31.4 30.9 32.5

Non-protein coding genes
Transfer RNA (tRNA) genes (+ tRNA pseudogenes) 467 (120) ~233 (26) 608 (213)c

5S ribosomal RNA (found in scaffolds and orphan contigs) ~29 ~400 ~100c

aNumber of genes includes seven predicted pseudogenes. Splice variants were not taken into account. Between 
14,500 and 17,800 genes have been estimated  after inclusion of genes potentially present in unannotated portion of 
the genome.
bAccording to Wormpep version 183.
c According to Spieth et al. 2006
*  M. incognita: flow cytometry;  B. malayi: flow cytometry and clone-based;  C. elegans genome has been completely 
sequenced telomere to telomere (no gaps) and is exactly 100,291,840 bp.

1.1.3. Automatic functional annotation

For  functional  and  comparative  analysis  of  Interpro  domains found  in  the  predicted  M. 
incognita proteome,  we  ran  the  program  InterproScan  on  a  set  of  seven  different  other 
species: 

- three nematodes (C. elegans [WormPep183], C. briggsae and B. malayi)
- one insect (D. melanogaster) 
- three fungi (M. grisea, G. zea and N. crassa). 

We attributed IPR domains, assigned associated Gene Ontology terms, and identified protein 
with  signal  peptide  using  SignalP as  embedded  in  Interproscan.  To  homogenize  the 
granularity level of annotation between organisms, for each non-overlapping set of domains 
found,  we only  kept  the  root  domain.  We used  the  hierarchical  organization  of  domains 
proposed  in  the  “Parent-Child”  description  available  on  the  EBI  public  ftp  server.  For 
example, all  CYP proteins which have a P450 domain (IPR002949, IPR002397,  IPR008070 
…) were counted at their root domain (IPR001128). 

We also generated clusters of orthologous protein-coding genes between M. incognita and the 
seven other species listed previously using OrthoMCL. Clusters were constructed on the basis 
of multidirectional reciprocal best Blast hits with a MCL clustering algorithm. This method 
allows  clustering  of  candidate  orthologs  between  different  species  but  also  includes  in-
paralogs  (resulting  from  species  specific-duplications)  inside  clusters.  Thus,  OrthoMCL 
clusters can range from one-species clusters (only composed of species-specific in-paralogs) 
to eight-species clusters (representing genes shared between all the species considered here). 

Results of functional annotation are displayed on predicted protein forms (paragraph 1.2.3.) 
and OrthoMCL (paragraph1.2.5.) that you can access through the website. 

To perform M. incognita automatic structural  and functional annotations,  public databases 
and programs have been chosen to avoid errors propagation. However M. incognita automatic 
annotations still have to be look at with caution since sequencing errors, redundancy or poor 
annotation coherence could still be found in such databases. 
When you are interested in M. incognita gene or gene family, you first have to verify and/or 
correct automatic annotation. It is what we propose to do during this workshop thanks to the 
different tools available on M. incognita website.
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1.2. M. incognita Website

During the workshop, you will access all the tools for structural and functional annotation as 
well as predicted protein description forms via M. incognita website:

http://meloidogyne.toulouse.inra.fr/cgi-bin/consortium/meloidogyne.cgi

Until now, access to M. incognita annotation tools through the website has been restricted to 
the consortium through a login and password. By the end of 2008, we plan to open access to 
public for Blast (paragraph 1.2.1), predicted protein description forms (paragraph 1.2.3) and 
Gbrowse (paragraph 1.2.3) only. 

If you wish to join the  M. incognita consortium, you are welcome to do so by sending a 
request to Pierre Abad and signing an agreement form.

1.2.1 BLAST

Similar to the BLAST server you use at NCBI except search focuses on M. incognita and 
nematode libraries and databases.

Figure 3: Blast server homepage
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▪ Available M. incognita libraries

- Contigs from M.incognita genome assembly - also on display in Gbrowse and/or Apollo 
(see paragraph 1.2.4.).

Mi geno (scaffolds 10X) (CNS 2007-10)

- Unassembled reads from M.incognita genome assembly
Mi unplaced reads (CNS 2007-10)

- M. incognita BAC Ends Sequences
Mi BES (NCBI)

BAC End sequences downloaded from NCBI servers
Mi BES (CNS 2008-01-31)

BAC End sequences generated by INRA Sophia Antipolis

- M. incognita predicted proteins from the automatic prediction pipeline (EuGene)
Mi proteins (Annotation structurale MincV1A1)

-  M. incognita EST - also on display in Gbrowse and/or Apollo (see paragraph 1.2.4.).
Mi dbEST (NCBI, update 2008-11)

EST from NCBI dbEST
Mi EST MiJ2 (CNS 2006-05)

EST sequences from a M. incognita library at J2 stage - generated by INRA Sophia Antipolis
Mi EST MiEg (CNS 2007-08)

EST sequences from a M. incognita library at Egg stage - generated by INRA Sophia Antipolis
Mi clustEST (from J2Mn, J2J3, J2-2006, Eg, dbEST): 

Cluster of all available M. incognita  ESTs (including NCBI dbEST)

▪ Public available nematode genomic and protein sequences 
 
- Genomic and protein sequences from C. elegans, C. briggsae, C. remanie, C. japonica and 
P. pacificus are available on the Blast server:

Celegans geno WS196 (FTP wormbase)
Celegans proteins WS196 (FTP wormbase)
Cbriggsae geno WS196 (FTP wormbase)
Cbriggsae proteins WS196 (FTP wormbase)
Cremanie geno WS196 (FTP wormbase)
Cremanie proteins WS196 (FTP wormbase)
Cjaponica geno WS196 (FTP wormbase)
Cjaponica proteins WS196 (FTP wormbase)

Ppacificus geno (FTP wormbase)
Ppacificus proteins (FTP wormbase)

1.2.2 M. incognita predicted protein / families description form

Results of functional annotation are displayed on predicted protein /families description forms 
and OrthoMCL page that you can access through the website. 
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▪ Search function

Search function allows keyword search on forms describing M. incognita predicted proteins 
and  predicted  protein  families.  It  is  possible  to  run  different  searches,  here  are  some 
examples:

M. incognita predicted protein

Domain (Interpro, Pfam…)

Proteins on which a signal peptide has been detected 

An activity or a protein family 

▪ Predicted protein description form

For each predicted protein, functional annotations are summarized in a form. In this form are 
only displayed the information thought to be relevant  based on criteria  or filters  to avoid 
overloading the form with noisy data.

Figure 4: M. incognita predicted protein description form 

Description of “FT” line (Filtered Feature):
−  Hit with domains (InterPro, Pfam, PROSITE, SMART, SignalP, TMHMM, …)
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− BLASTP hit  if  the  hit  covers  80% of  the  database  subject  sequence  (DmelDB, 
BmalDB, MincDB or WormPep) and 80% of the query sequence (query= proteinMinc00146) 
and with an e-value inferior to 1e-4 

− BLASTP versus SP/TrEMBL. Display only the best hit with our reference organism 
(C. elegans),  ie  the first hit found with a  C. elegans  protein from SP/TrEMBL in a match 
region. If there are several hits of C.elegans SP/TrEMBL at different positions, we display the 
best hit at each position. 

▪ Classification of M. incognita predicted proteins into families

M. incognita predicted proteins have been grouped into families by:

− blastp of M. incognita predicted proteins against themselves
− filters: e-value < 1e-4 and hit covering more than 80% of the query and the subject 

sequences
− if protein A matches with protein B passing the 80% and 1e-4 thresholds and if 

protein B matches with protein C (passing the 80% and 1e-4 thresholds), then the proteins A, 
B and C are grouped in the same family, even if the match between A and C do not pass the 
80% and 1e-4 thresholds.

Through the website you can access the list of all M. incognita predicted families and also 
detailed description of each family: 

Figure 5: List of predicted M. incognita families 

From this  list,  you  have  access  to  detailed  family  forms.  For  instance,  when clicking  on 
family 28 (fam:MincF00028) on the list, you access the page that describes the members of 
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this family. This page lists all the family members and graphically describes their domains 
(PFAM, PROSITE, INTERPRO, SignalP, TMHMM, ...) if any.

Figure 6: M. incognita predicted “fam:MincF00028” description form 

▪ OrthoMCL

We ran OrthoMCL on  predicted protein sets from M. incognita (minc) and 7 other species 
whose whole genomes have already been annotated:

− Three nematodes: C. elegans (cele), C. briggsae (cbri), B. malayi (bmal),
− One insect: Drosophila melanogaster (dmel),
−  Three  fungi:  Magnaporthe  grisea (mgri),  Gibberella  zeae (gzea),  Neurospora 

crassa (ncra)
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Figure 7: Display of OrthoMCL results on M. incognita website
Groups are sorted by decreasing size. Note that in a given OrthoMCL cluster, the presence of 
several  proteins  from  a  same  species  indicates  “inparalogs”  (species  specific  gene 
duplications, in other words, duplications that took place after the speciation of the considered 
organisms). 
OrthoMCL clusters  with a single taxon can occur.  They simply reflect  the fact  that  these 
species  specific  proteins  returned  no  best  reciprocal  BLAST  hits  with  other  considered 
species. 
You may also notice huge groups with a small number of taxa. For OrthoMCL, these groups 
reflect families that have undergone independent lineage-specific expansions after speciation 
in the considered taxa. 

1.2.3 KEGG Pathway

We tried to assign EC numbers to  M. incognita predicted proteins. We used the following 
criteria:

− blastp of all M. incognita predicted proteins against a database of Swissprot proteins 
that have been assigned an EC number

− filter with a < 1e-4 e-value threshold and requirement that the hit covers at least 80% 
of the Swissprot sequence.

We  retrieved  KEGG maps  of  metabolic  pathways  from  C.  elegans.  On  these  maps,  EC 
numbers assigned to M. incognita predicted proteins are colored in red. EC numbers found in 
C. elegans proteins are colored in green
You can access the list of KEGG maps from the website:

Figure 8: Display of Kegg pathway results on M. incognita website
13



1.2.4 Genome Browsers:  Gbrowse and Apollo

You can  access  the  chado database  via  genome browsers  (Gmod tools):  Gbrowse and/or 
Apollo.  Automatic  annotations  can  be  modified  by  annotators  only  on  Apollo.  Apollo 
annotation platform will be presented in detail later on (paragraph 1.3). 

▪ Gbrowse

You can display a region of interest and select the features you want to visualize (gene, 
mRNA, CDS, ESTs  and repeat

Figure 9: Overview of Gbrowser interface
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1.3. Apollo – Annotation platform

In this section, we only summarize Apollo customization for M. incognita genome. You will 
find a complete Apollo description on Apollo user guide (paragraph 3). 

1.3.1. Apollo as genome Browser

You  need to know which part of  M. incognita genome you wish to access before starting 
Apollo. 

▪ Connection to M. incognita chado database

To view a contig over its entire length:
Choose the name of the contig 
Enter "1" (Start) and the length of contig (End)

Contig size is provided in the document contig_length.txt

Figure 10: Apollo start window Figure 11: Apollo web start

When Apollo has loaded the data for the region you selected, the main windows will appear.

▪ Apollo display panels
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Figure 12: Overview of Apollo interface

Black panels show the raw computational results on M. incognita contigs:
Gene predictions (EuGene)
Potential Start/Stop codons
EST alignment (GenomeThreader) 
Other similarities (blastx and tblastx) 

Light blue panels closer to the axis show annotations that can be modified by annotators:  
Annotation: for now, equivalent to gene prediction (Eugene) since no manual expert 
annotation have been loaded in Chado database yet
Repeat regions (RepeatScout ant RepeatMasker)

. RNA

To zoom in for a closer view, use the x2 and x10 buttons. To zoom out, use the x.1 and x.5 
buttons. You can reset to the original zoom level with the «  Reset  » button. You can also 
select a feature and zoom from the menu.

View menu  - zoom to selected 
or Edit menu - Find

▪ Features 

Features are color coded and you can customize the Apollo display panel by (un)selecting 
data you need for expert annotation. 

Tiers menu – Show types panel

Figure 13: Available data for display on 
Apollo browser.

▪ Viewing, translating and saving sequence for selected features
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View menu allows customization of the display panel. For instance, you can choose to display 
forward strand only.

View – Select forward strand

Figure 14: Forward strand only on display panel 

If you click on one feature or select several features, the feature is boxed in red and more 
information about it will be displayed in the detail panel at the bottom of the main window. 

Figure 15: Selected feature information on display panel 

If you want to see the sequence of one or more features, select the feature and then use the 
right-mouse popup menu:

One left click will select one feature (ex: exon)
Double left click will select the entire feature (ex: predicted gene)
Right-mouse click
Sequence – Select sequence type
CtrlC-CtrlV to copy-paste the sequence
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Figure 16: Right-mouse popup menu Figure 17: Sequence of the selected feature

1.3.2. Apollo as genome Editor

As  seen  previously,  the  EuGene  combiner  was  used  to  build  a  consensus  annotation 
integrating  both  statistical  models  and  evidences  such  as  translation  starts,  splice  site 
predictions and EST for instance (paragraph 1.1). Even if automatic annotation is powerful, 
errors could occur in automatic annotations. Apollo genome editor will allow you to manually 
validate and/or correct structural annotations.

▪ Structural annotation

To correct structural automatic annotation, you have to keep in mind basic knowledge on 
protein-coding gene structure. 

Figure 18: Protein-coding gene structure

Open reading frame (ORF) 
DNA sequence between two stop codons 
Potentially coding sequence 
6 reading frames 
overlapping ORF

Coding sequence (CDS) 
Protein coding
start and stop codon 
all exons from one gene
1 CDS = 1 or more ORF
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▪ Apollo annotations

Automatic  annotations  from  the  light  blue  panel  can  be  modified  by  annotators.  Gene 
predictions need to be validated and/or modified by expert before further analyses. Apollo 
allows (details on Apollo User guide – Paragraph 3):

- Gene model creation
EST on black panel computational results but no predicted gene on annotation blue 

panel. Or, other piece of evidence (similarity to a known protein from an external database) in 
region where no gene had previously been detected.
- Gene model modification

Deleting or adding exons to an existing transcript
Merge exons - will remove the intron between two exons.
Split exon - will create a one base intron in the middle of an exon.

- Merge transcripts - merges all exons from two transcripts.
- Split transcript - will remove the intron connecting two exons and create two separate 
transcripts.

▪ Save your Apollo annotations

To avoid losing data by mistake, it is not 
possible to directly save modifications in the 
Chado database.
Meaning that you will lose your annotation 
work if you just close Apollo window 
without saving.

To save your annotation you can use 
“GAME XML” format. This will generate a 
new file on your computer. 
          File menu
          Save as
          Choose data source
          Game XML format

When you are done with structural and 
functional annotation, you can definitively 
record your work on the annotation form 
(paragraph 1.4).
         M. incognita website 
        Upload your annotation

Figure 19: Visualization of Chado database 
only

1.4. Saving curated structural and functional annotations

As said before, you cannot directly modify annotations in the chado database. However, once 
you  have  used  the  different  tools  to  perform an  expert  manual  functional  and  structural 
annotation, you can save your results thanks to a specific form link to the expert annotation 
database. Expert annotation form and database have been specifically designed by Emeline 
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Deleury (INRA Sophia Antipolis)  to keep track on expert  versus automatic  data and also 
implement / update the chado database every once in a while (Every 6 month - depending on 
activity).

The goal of this expert annotation database is to keep track of the different annotations for the 
same gene. As a result no annotation, neither automatic nor expert, will be eliminated from 
the Chado database.

Figure 20: Schematic representation of Chado and Expert annotation databases.

Each predicted gene is automatically associated to a description log that you can access 
through M. incognita website to save your expert structural and functional annotation –

Upload your annotation

Figure 21: Annotation form
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In parallel to your expert annotation, this application will automatically record parameters 
such as (highlighted in yellow in figure 21 above):

Gene_id: 
Minc number attributed by Eugene predictor – automatic structural annotation 
Ex: Minc07876
Gene-id is associated to gene_version:

EuGene version (automatic): Minc07876.0 
Annotator version (Expert manual annotation): 

Minc07876.1 - first person to correct Minc07876 gene model
Gene version will stay Minc07876.1 first person correct 
gene model more than once

Minc07876.2 - second person to correct Minc07876 gene model
Different from 1st expert annotation

Minc07876.3 - third person to correct Minc07876 gene model
Different from 1st and second expert annotation

Status: 
Automatic
Curated (validated or modified)
Deleted

Annotator:
Name (login) of the annotator who has changed gene status from automatic to curated

Date_creation: gene creation date    Date_modification: gene structure last modification date

▪ Expert structural annotation

When  you  open  an  annotation  form,  depending  on  modifications  previously  made  by 
annotators,  several  status  combinations  could be displayed  on this  section (highlighted  in 
yellow in figure 21 above):

Gene id Gene
version Status Annotator Date Track

MincXXXX .0 automatic automatic EuGene date -
Gene creation

MincYYYY
new .1 curated created annotator_id date_creation -

Gene validation
MincXXXX .0 curated validated annotator_id date_validation -

Gene error (no modification)
MincXXXX .0 automatic invalidated annotator_id date_invalidation -

Gene suppression
MincXXXX .0 deleted deleted annotator_id date_suppression -

Gene modification

MincXXXX .0 deleted modified annotator_id date_modificatio
n -

MincXXXX .1 curated modified annotator_id_A date_modificatio
n .0 and .1

MincXXXX .2 curated modified annotator_id_B date_modificatio
n .0 and .2

Gene fission
MincXXXX .0 deleted splitted annotator_id date_scission -
MincXXXX .1 curated splitted annotator_id date_scission   .0 and .1
MincYYYY

new .1 curated splitted annotator_id date_scission .0 and new 
.1

Gene fusion
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MincAAAA
A.0 .0 deleted merged annotator_id date_fusion A.0 and 

A.1

B.0 and 
A.1

MincBBBB 
B.0 .0 deleted merged annotator_id date_fusion

MincAAAA
new A.1 .1 curated merged annotator_id date_fusion

Gene status  will  allow any annotators  to  access  expert  annotation  even if  it  hasn’t  been 
downloaded in Chado database yet. This application allows multiple annotations (.1, .2, .3, 
etc.)  for  one single  gene.  However,  we recommend  that  annotators  contact  each  other  to 
discuss their annotations and limit gene version. 
Be aware that if you validate an automatic status (MincXXX – curated – validated), you will 
not able to modify the structural annotation later on.

▪ Expert functional annotation

Note  that  if  you  only  want  to  record  a  functional  annotation,  you  have  to  comment  on 
structural annotation first.
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2.  M. incognita   genome annotation tools practical  

The Aims of this practical are 2-fold: 
-  Familiarise yourself  with  M. incognita genome annotation tools (and some freely 

available software)
-  Perform manual validation and/or correction of protein-coding gene structural and 

functional automatic annotation.

To do so,  we will  focus on  one example during the course.  We have chosen  an aspartic 
proteinase from Meloidogyne incognita, Mi-asp1. Proteinases are of interest for INRA Sophia 
Antipolis  lab  and  Fragoso  et  al. (2008)  just  reported  Mi-asp1  cDNA  cloning  and 
characterization.

▪ Background

Accession number
The Mi-asp1 accession number in GenBank is DQ360827 (NCBI website):
Meloidogyne incognita cathepsin D-like aspartic proteinase preproprotein (asp1) 

mRNA, partial cds
gi|86278344|gb|DQ360827.1|[86278344]

Blast (Fragoso et al. 2008)
The nucleotide  sequence of  Mi-asp1  was used as  a  query in  BLAST searches  within  the 
Caenorhabiditis elegans genome at WormBase and within the plant-parasite nematode dbEST 
at  the  Nematode  Center.  A  GenBank search  at  NCBI  was  also  done  using  as  a  query 
combination  of  words  that  specify  developmental  stage  and  gene  annotation  after  the 
Taxonomy ID of the RKN (189290).
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Signal peptide / Conserved domain

No start codon - Stop codon: TGA
Signal peptide: GCCTTGGTTAGTTCT
Conserved domain of eukaryotic aspartyl proteinase: PFAM00026
A putative polyadenylation signal at the 3’ UTR: AATAAAA
Pro-domain (pro-region): 

IRHHHSRHHHHVDRISLSRMDTMRSMLAQVGSLELFAKHRHDALRRRFALFAEKEGGQVEFD
EENAVQIGG

▪ Materials for the practical

Each PC is provided with a directory containing:

- M.incognita website - Access to previously presented tools: Blast, Search function, 
predicted protein/family forms, OrthoMCL, Gbrowse and Apollo  

      http://meloidogyne.toulouse.inra.fr

- jalView website – a program for multiple alignments

- Contig_lenght.txt file

 2.1. Practical part 1 - Automatic annotation

M.incognita   website   allows access to data, tools and searches you need to perform expert 
manual M. incognita functional and structural annotation. Note that there are many ways to 
find useful information to annotate your genes of interest. We propose one way to test as 
many tools as possible.

2.3.1. Finding information about Mi-asp1

▪ M. incognita predicted protein set

- Start from M.incognita website by clicking on the link. 

- Familiarise yourself with the layout and menus. 
Go to “Consortium”
Go to “Tools”
Go to “Blast”

- Select Miasp1 protein sequence from NCBI website
- Copy/paste Miasp1 protein sequence 

select Blastp  – Mi proteins (Annotation structurale MincV1A1)
select tBlastx – Mi dbEST (NCBI update 2008-11) and other EST libraries
select tBlastx – Mi geno (scaffolds 10X) 
select tBlastx – Mi unplaced reads (CNS2007-10)

Use the sliders to view the alignment
Keep track of your blast results for the following analysis

- Go to “Families” – Search box
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- Get information from best blast hits against predicted M. incognita predicted proteins 
identified during the Blast search. Simply fill the protein accession numbers in the search 
box.

Questions
Does your sequence match predicted protein? If yes, does your sequence span the 
complete alignment, or only a bit of it? How many hits do you obtain? e-value?
Is it informative data?
What is the automatic predicted annotation for best blast hits?
Do predicted proteins have orthologs?

▪ Finding information about aspartic proteinase from M. incognita

- Try the Search function with different key words
Proteinase
Aspartyl proteinase
PFAM 00026 
 

Questions
How many hits do you obtain for each search? Is it informative data?
Does your sequence match some of the predicted proteins found thanks to function  
search? If yes, does your sequence span the complete alignment, or only part of it? 

2.2. Practical part 2. Apollo as a browser

You have previously identified M. incognita predicted protein, domain, EST, etc that could be 
informative about  Miasp1  sequence. You will now visualise all those data on  M. incognita 
genomic sequence.

1.2.1. Displaying information on Apollo 

We will start our study about Miasp1 sequence with the best blastp hit against M. incognita 
predicted protein: prot:Minc00916.

▪ Best blastp hit predicted protein 

Result from the Blast of your sequence against the predicted proteins (MincV1A1 - automatic 
annotation) indicates the position of the gene corresponding to your hit on a  M. incognita 
contig. Contig name and positions are the parameters that you must enter to view your gene 
into Apollo.

- Start from M.incognita website 
- Go to Apollo

Enter the name of the contig of interest: MiV1ctg13
Enter "1" as Start

 Enter length of contig “264764” as End 
25



- Familiarise yourself with the layout.
Zoom in – Zoom out - Reset
Use the scrollbar just above the zoom buttons
Drag the Splitters (red triangles) up or down on each strand to adjust the panels.

- Go to Edit menu - Find
Enter the sequence you're looking for in the 'Name' text area. 
Find
Drag the Splitters (red triangles) up or down on each strand to adjust the panels.

- Go to File menu – Open new
Enter the name of the contig of interest: MiV1ctg13
Enter "40000" as Start

 Enter “52000” as End 

 - Go to View menu 
Show forward strand
Drag the Splitters (red triangles) up or down on each strand to adjust the panels

Show reverse strand
Drag the Splitters (red triangles) up or down on each strand to adjust the panels

▪ Specify which features to display

- Find sequence 
Search for EST sequences described by Fragoso et al. 2008. 

Right click in the exon detail editor window
Left click on 'Find sequence'
A window will pop up
Enter the sequence you're looking for in the 'Sequence' text area. 

You can use regular expressions in your search string 
Left click on 'Search'

If the sequence is found, the coordinates will appear in separate boxes below

- Change the strand of a result (ex: EST contig)
If a result feature has been assigned the wrong strand you can move it to the other strand 

Select the result feature: 
MiallEST_contig_est: Miall_CL218 Contig1 - 9966855

Right click to get the popup menu
Select "Move to other strand"

- Go to Tiers menu 
Show all types panel
Select / unselect types / labels
Drag the Splitters (red triangles) up or down on each strand to adjust the panels

Collapsed view / Expanded view
Decrease / Increase tier height

Questions
What kind of features / types can you display matching Minc00916 predicted  gene?On 
hich strand?
Do similarity results (EST, tblastx…) span the complete Minc00916 sequence? Are there 
inconsistencies, splice variant?
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1.2.2. Finding out more about annotations and features

By zooming  on features,  you  can  visualize  feature  sequences.  You can also import  fasta 
feature sequences.

▪ Sequence of selected features

- Select one exon by clicking on that feature 
Right-click popup menu
Sequence 

If "Sequence..." is grayed out, it means you haven't selected any features that have sequence 
associated with them 

- Select more than one exon by double clicking on that 
Right-click popup menu
Sequence

- Select EST
Right-mouse popup menu
Sequence

- Create a multiple-FASTA file 
cDNA sequence (just the exons) 
coding sequence (from start of translation to stop).

▪ Viewing alignment

To let  you examine  the alignments  between different  features  and the genomic  sequence, 
Apollo has an interface to the Jalview multiple alignment viewer. 

- Choose one or more features (results and/or annotations)
Example: 

Result: MiJ2_est: mij211b01r1.1-9966884
Annotation: Minc00916

Select all of MiJ2_est with a double left click (left mouse)
Depress shift key
Select all of Minc00916 with a double left click (left mouse)
Right click to bring up popup menu 
"Align selected features" or "Align same type features in region"

- Customize your alignment
Colours menu
Click Zappo / Taylor (amino acid properties)

Questions
Will you validateMinc00916 predicted gene structure? What modifications will you apply  
and why? 
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▪ Minc00916 automatic functional annotation

Automatic  functional  annotation  is  based on sequence similarity.  Blast  results  have to  be 
looked at carefully since functional annotation could be wrong (see below).

Questions
Will you validateMinc00916 predicted functional annotation and why? 

 If you have time, look for information on  the N-term part of Minc00916 (Blast…)

2.3. Practical part 3 - Apollo as a curation tool

The previous sections have dealt  with using Apollo as a browser. If you are annotating a 
genome, you may be interested in using Apollo as a curation tool. 

1.3.1. Using Apollo to edit annotations

▪ Minc00916 gene structure modification 

- Create a new Minc00916 transcript  Minc00916-transcript1:temp
Select result on which to base the annotation: Eugene Minc00916 prediction
Drag it into the light blue annotation zone
Drop it, an annotation will be created 

- Modify Minc00916-transcript1:temp gene structure
Delete exon: 

Select the unwanted exon(s) - you can use shift-click to select multiple features
Right click to bring up popup menu
Select "Delete selection"

Merge exons: 
Select exon 6
Hold the shift key
Select exon 7 in the same transcript
Right click to bring up popup menu
Select 'merge exons'

Questions
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Is Minc00916 corrected? Will you perform other modifications? How and why?

▪ Minc00916 gene structure modification (bis)
There are different ways to do the same correction on Apollo. Here, you’ll do the exact same 
modifications as before but only a different way. 

- Create a new Minc00916 transcript (bis)  Minc00916-transcript2:temp
Select existing annotation Minc00916
Right mouse popup menu option "Duplicate transcript"

- Modify Minc00916-transcript2:temp gene structure
Split transcript:

Select exon at one end of split location
Hold shift key
Select exon at other end of intron where you want the split to occur
Right click and get popup menu
Select 'split transcript'
 Minc00916-transcript2:temp and Minc00916-transcript3:temp

- Create a new transcript from existing EST  MiJ2_est: mij211b01r1.1-9966884
Select EST or (exon from EST) on which to base the annotation: mij211b01r1.1

Edit – Find - Searched for EST - mij211b01r1.1
Drag it into the light blue annotation zone
Drop it, an annotation will be created   Minc00916-transcript4:temp

- Move exons from Minc00916-transcript4:temp (EST) to Minc00916-transcript3:temp 
Select all of Minc00916-transcript3:temp with a double left click (left mouse) 
Hold shift key
Select exon(s) from Minc00916-transcript4:temp (EST)
Right mouse popup menu option 'Move exons to transcript'

The exons from Minc00916-transcript4:temp (EST) are removed from Minc00916-
transcript4:temp (EST) and added to Minc00916-transcript3:temp

Questions
Is Minc00916 corrected? Will you perform other modifications? How and why?
Is this gene model compatible with splice donor and acceptor sites?

▪ Minc00916 gene structure modification – search for peptide signal

- Find peptide signal from Fragoso et al. 2008 
Edit menu
Left click on 'Find '
A window will pop up
Enter the sequence you're looking for in the 'Sequence' text area: 

GCCTTGGTTAGTTCT
Left click on 'Search'
If the sequence is found, the coordinates will appear in separate boxes below
Click on the coordinates

- Use SignalP program to look for peptide signal on your corrected Minc00916 sequence 
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Questions
Will  you modify  5’?  Is  Minc00916 structural  annotation corrected? Can you perform 
other modifications? 

 If you have time, perform structural annotation on the Minc00916-transcript2:temp

▪ Save your Minc00916 gene structure annotation

You cannot directly save modifications in the Chado database. Be careful: You will lose your 
annotation work if you just close Apollo window.

To save Minc00916 annotation you can use “GAME XML” format. This will generate a new 
file on your computer. 
          File menu
          Save as “Minc00916_protease_Miasp1”
          Choose data source: Game XML format

OK
The file should be on the desktop. You can verify:

File menu
Open
New
“Minc00916_protease_Miasp1”

2.4.   Practical part 4   – Uploading your curated annotations in the database 
through the web form

As an  example,  we will  save  structural  and functional  annotations  for  Minc00916.  Once 
Minc00916 annotation has been curated by one annotator, no one else will be able to proposee 
exactly the same curation again. This avoids the existence of multiple gene versions that are 
exactly the same.  However,  any annotator  can propose further  modifications to the initial 
correctedversion,  this  will  implement  the version number.  During the workshop, you will 
change structural gene annotation just for practice (without biological meaning). The expert 
annotation database will be reset after the workshop.

Each participant will have to modify and save annotations for his own set of predicted genes. 
On Minc number list, Select automatic/automatic.
You will have to:

- Validate an existing annotation
- Modify an existing annotation

Merge two existing annotations
Split an existing annotation

- Create a new gene
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2. Apollo User Guide - Version 1.9.x May 2008  

3.

Introduction

Apollo is a genomic annotation viewer and editor. It was originally developed as a 
collaboration between the Berkeley Drosophila Genome Project (part of the FlyBase 
consortium) and The Sanger Institute in Cambridge, UK. It was used by the FlyBase 
biologists to construct the Release 3 and 4 annotations on the finished Drosophila 
melanogaster genome, and has also been a primary vehicle for sharing these annotations with 
the community. 

Apollo allows researchers to explore genomic annotations at many levels of detail, and to 
perform expert annotation curation, all in a graphical environment. It is a Java application that 
is easy to install and run on Windows, Mac OS X, or any Unix-type system (including Linux). 
Apollo is currently supported by NIH grant 1R01GM080203-01 from the National Institute of 
General Medical Sciences (NIGMS). 

The current Apollo team is: 

• Ed Lee (leader and chief developer)
• Nomi Harris
• Mark Gibson
• Suzanna Lewis

The original Apollo developers were: 

• Steve Searle
• Michele Clamp
• Suzanna Lewis
• John Richter

Other contributors have included: 

• Sima Misra
• Guanming Wu
• Jonathan Crabtree (Chado JDBC adapter)
• Vivek Iyer
• Craig Melsopp
• Chris Mungall
• Colin Wiel
• Chris Wilks
• Olivier Arnaiz
• and all the FlyBase curators

The Apollo community

An increasing number of research groups are using Apollo as a starting point for customizing 
their own annotation visualization tool. Because Apollo was developed from the beginning to 
serve the needs of two groups working on different organisms (fruitfly and human) with 
different types of data, it was specifically designed to be flexible and extensible. The Generic 
Model Organism Database (GMOD) project, which aims to provide a complete ready-to-use 
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toolkit for analyzing whole genomes, has adopted Apollo as its annotation workbench. Apollo 
is Open Source; the Apollo source code is all available at SourceForge as part of the GMOD 
project. 

Reporting bugs

Apollo is still under active development, and there are still many bugs--some we know about, 
and some we don't. The bugs we know about are listed in the SourceForge Apollo bug tracker. 
If you encounter a problem that is not in the list of reported bugs, please submit a new bug 
report or ask on the Apollo mailing list. Please be as specific as possible when you report 
bugs--tell us which version of Apollo you're running, what dataset you were looking at, what 
operating system you're on (including the version number), and what you did that caused the 
bug. Also send us the output from the Java console (see the section on Text output from 
Apollo). 

When you report a bug, be sure to include your email address. We may need to ask you 
questions in order to track down the bug, and you'll probably want to know when we've fixed 
it. You will not be added to any mailing lists or sent any other correspondence. 

Mac users, please note: the top-level menu item that says "About Apollo" purports to tell you 
the Apollo version number, but in fact it's telling you the version number of the installer. To 
get the correct Apollo version number, use the "About" item from Apollo's Help menu. 

Apollo mailing list

If you are interested in discussing Apollo with other users, you can join the Apollo mailing 
list. Traffic is low, and your email address will not be made publicly visible or used for any 
other purpose. In order to reduce spam on the list, you must join in order to send messages to 
the list. To unsubscribe from the mailing list, use the same Web form. 

Installing Apollo

Apollo is a Java application that you can download and run on your computer (Windows, 
Linux, or Mac OS X--earlier Mac versions are not supported). You can get Apollo here. 
When you install Apollo, a JVM is bundled with it, unless you are on Mac OS X. 

Getting the appropriate Java on a Mac

Apollo is now set up to run with JDK1.5 or 1.6, so make sure you have one of these versions 
of Java installed. You will need Mac OS X 10.4+ to install JDK1.5. Please see Apple's 
instructions on how to do this, using Software Updates. (Apollo cannot run on older versions 
of Mac OS X.) 

Some versions of Mac OS X have Java issues--standalone Java applications (such as Apollo) 
may unexpectedly quit or not launch. You can perform a simple test to verify whether your 
computer is experiencing this issue. If it is, you will need to reinstall one or two Java software 
updates to resolve the issue. Please look here for help. 

Memory use

Apollo uses a lot of memory, largely due to the sheer size of the annotation data. In order to 
use Apollo, your computer will need to have at least 256Mb of RAM. Moreover, even if you 
have that much memory, you will probably find that if you try to run more than one instance 
of Apollo at the same time, performance will suffer. Also note that if you load a very large 
region, Apollo will use up more memory. 
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Keep in mind that other applications running on your computer also use memory, so you will 
get better performance if you shut down other applications (Photoshop, Word, etc.) before 
you launch Apollo. 

Apollo checks twice a minute to make sure you still have enough free memory. If the free 
memory is getting very low (less than 5% of the the value defined as "Memory" in 
apollo.cfg), you will get a warning. If you have done or are planning to do any editing, you 
should save your work and then quit and restart Apollo. 

If you load many large regions into Apollo (such as cytological bands), it is possible that it 
will run out of memory despite the memory checks. Usually the behavior you'll see if this 
happens is that it will freeze up during loading, but sometimes other things will start to go 
wrong. If you then look at the Java console, you may see "java.lang.OutOfMemoryError". If 
this happens, you should exit Apollo and restart. 

Starting up

Unix
From the directory where Apollo is installed, type 

./Apollo
You should also be able to run Apollo from other directories by specifying the full path. 

Windows or Mac
Select the Apollo icon from your desktop or dock. 

Note for Mac users running Panther (10.3): Some security-related software updates on 
Panther interfere with Java and prevent Apollo from launching from the shortcut (you will see 
the icon bounce a few times and then stop, and no Apollo window comes up). We are looking 
into how to address that, but there are two workarounds. Either: 

  Upgrade your Mac to Tiger or Leopard; or
  Launch Apollo from the command line. First, start a Terminal window (Applications -> 
Utilities -> Terminal). In the Terminal window, cd to the directory where you installed 
Apollo, usually /Applications/Apollo, and type ./bin/apollo (note the lowercase a):

cd /Applications/Apollo
./bin/apollo

You will see the text output from Apollo in the Terminal window, and an Apollo window 
should come up. 

Note: if you want to run Apollo from the command line, it will not be able to control which 
version of the Java virtual machine your Mac defaults to using (as it does if you run the 
installed Apollo). Please make sure that you are set up to use JDK version 1.5 or 1.6, rather 
than 1.3, which is the default on some older Macs. 

The first view of Apollo

When Apollo starts up you should see the Apollo splashscreen, which will stay up for a few 
seconds while the Apollo software loads. 
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You should then see a window offering various ways to find the region you are interested in. 
These will be discussed shortly. 

Text output from Apollo

Sometimes it's important to see the text output from Apollo--the messages it prints to inform 
the user about what it's doing. This is particularly true if something's not working right and 
you want to report a bug. Both standard output (stdout) and standard error (stderr) messages 
are captured into log files. They are located at:

$APOLLO_ROOT/logs/stdout.log
$APOLLO_ROOT/logs/stderr.log

where $APOLLO_ROOT is the location where Apollo was installed. Note that stdout/stderr 
are only captured into log files if you installed Apollo with the installer program. If you are 
running Apollo directly from the source code, stdout/stderr won't be redirected and will 
display on the terminal where you're invoking Apollo from.

Loading Data

Reading data from a file

The oldest and, in many ways, most fully-functional data adapter in Apollo is the GAME 
XML adapter. The simplest way to try out Apollo is to choose the GAME XML adapter from 
the "Choose data source" start screen, and load data/example.xml (a GAME XML file that 
contains computational results and curated annotations for a region of the D. melanogaster 
genome), which is included with the Apollo distribution. 

Reading Drosophila annotation data
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The annotations on the Drosophila melanogaster genome are now stored in a version of the 
Chado XML format. Drosophila annotation data in Chado XML format can be read from a 
file or pulled transparently across the network from the FlyBase annotation database. 

Apollo provides several ways to search for the Drosophila region you are interested in: 

• Filename (e.g., data/CG16983.chado.xml)--filenames can use absolute or relative 
paths (relative paths are taken to refer to files inside the Apollo directory). Please note 
that if you use the Browse button to select a file, you still need to hit the "Ok" button 
to begin loading the file. (You can also enter an URL as a filename.) 

A quick tip about the file chooser that is invoked by the Browse button: by default, it 
comes up in a mode where you scroll horizontally to see all the available directories 
and files. If you prefer vertical scrolling, click on the icon at the top right of the 
chooser window, which looks like two little squares, each followed by a line. 

• Gene name (e.g., cact)--finds the region surrounding the gene 
• Cytological band (e.g., 40B). Warning: these are big and use up a lot of memory. 
• Location: chromosome arm, start and end position (e.g., 3R 100000 300000) 

By clicking on the tabs labeled "Gene", "Cytology", etc., you can decide how you want to 
look for the region of interest. Note that the FlyBase server will return the scaffold (~350Kb 
region) that is closest to your query, not the precise region you requested. 

Note that except for the "File" search, all the searches go over the network to get the 
Drosophila annotations from the FlyBase server, so you must be connected to the internet to 
use them. Sometimes it takes a while to fetch the data across the internet. Sometimes, the 
database is down, or is so overloaded that you will get a message saying "can't connect to 
URL". Another possible cause of that message is that you might have a firewall that prevents 
the data from getting to your computer. If you use a proxy, be sure to set the proxy by 
clicking the "Proxy settings" button before trying to load data. 

If you'd like to download all the FlyBase Drosophila annotation data to your computer so you 
can then access it locally via the File tab, please visit http://flybase.bio.indiana.edu/annot/. 

Reading Chado XML or GAME XML files

The Chado XML adapter lets you read and write FlyBase-style Chado XML files with no 
macros. A sample Chado XML file containing some Drosophila annotations, 
data/CG16893.chado.xml, is included with the Apollo distribution. 
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The Chado XML adapter has not yet been generalized for use with non-FlyBase data. Also, it 
cannot yet handle macros, and it doesn't yet deal with some types of "non-Apollo" data such 
as feature_cvterms. Theoretically, you can use Apollo as a converter between Chado XML 
and GAME, but we are still debugging that conversion. Please see doc/todo for a list of 
known issues with the Chado XML adapter. 

The GAME XML adapter was written to handle Drosophila data in the older GAME XML 
format. You should be able to use it to read other types of annotation data in GAME XML 
format, but you will need to change the tiers file. 

You can also write out two different GAME XML versions (1.0 and 1.1). This is configurable 
in style--set DO_ONE_LEVEL_ANNOTS "false" makes it save 1.0, otherwise it saves 1.1. 

Reading data directly from a Chado database

The Chado JDBC adapter allows Apollo to read annotation data directly from a Chado 
database. Using this adapter to read data from your Chado database will require modification 
of some configuration files. 

If you want to try reading Drosophila annotations from the FlyBase Chado server (which 
might or might not still be running), select "Chado" from the data adapter list. There is only 
one database to choose: "FlyBase Chado Indiana public server". You can then choose "Type 
of Region" to be either "gene" or "golden_path_region." golden_path_region is a scaffold (it's 
the Sequence Ontology term for a scaffold). In the "Region ID" box, enter the gene name (if 
you selected type gene) or scaffold ID (if you selected golden_path_region). An example of a 
fruitfly gene is "cact". An example scaffold ID is AE003603. 

The Chado adapter has known bugs that are described in doc/chado/chado-jdbc-todo. For 
example, if you request a region that doesn't exist, Apollo will seize up. Also the dashed 
contig result lines that are present from the GAME Adapter are not coming up yet. See chado-
jdbc-todo for the full listing. 

Also, if you ask the server for data by chromosome region (e.g., 2L:10000-20000), you may 
get an entire scaffold that includes the requested gene or region--not the actual region 
requested. This is a bug in the server, not Apollo (as of v. 1.6.5). 

The Chado data adapter can do direct-to-database writeback. It converts the transactions to 
updates to the chado database, so only edited features are updated in the database. Currently 
this is working with the Chado Rice database (at Cold Spring Harbor). Adapting it to other 
Chado databases shouldn't be too hard. 

If you are a developer who wants to enable Apollo to access your own Chado database, please 
see the section about customizing the Chado adapter. 

Reading Ensembl GFF files

GFF format is a simple format for transferring genomic annotations. A version of GFF 
(Ensembl GFF) is used at the Sanger Institute for storing the human annotations. 

To read in an Ensembl GFF file, choose the "Ensembl GFF" option from the data adapter 
menu. You can type your GFF file name in the text box or press the Browse button to bring 
up a file chooser. You can also enter a FASTA-format sequence file name to go with the GFF 
data. When you're ready, press the OK button and the GFF file (and sequence file, if you 
specified one) will be read in and the features displayed. 
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If any of the features in the GFF file have types that are not recognized by Apollo they will be 
given a default pale yellow color. This can be changed in the Preferencessection. 

Please note that there is more than one flavor of GFF, and Apollo only supports the Ensembl 
flavor (as described here). Apollo does not understand the Artemis flavor of GFF. 

Also note that Ensembl GFF format is not rich enough to support curated annotation, so even 
if you turn on editing, you will not be able to create and save curated annotations on GFF-
format data. 

Finally, note that although theoretically Apollo can be used to convert between data formats 
(e.g. GFF <-> GAME), in practice this is not foolproof. 

Reading GFF3 files

GFF3 format is the current generation of a simple format for transferring genomic 
annotations. 

To read in an GFF3 file, choose the "GFF3 format" option from the data adapter menu. You 
can type your GFF3 file name in the text box or press the Browse button to bring up a file 
chooser. You must either provide the sequence data in FASTA format or you will need to 
have the FASTA data embedded in the GFF3 file. For the first option, make sure that 
"Embedded FASTA in GFF" is not checked and enter the FASTA file to go with the GFF3 
data (you can browse for the file as well). For the second option, make sure that "Embedded 
FASTA in GFF" is checked. This will disable the "Sequence file" selection. When you're 
ready, press the OK button and the GFF3 file and sequence data will be read in and the 
features displayed. 
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If any of the features in the GFF3 file have types that are not recognized by Apollo they will 
be given a default pale yellow color. This can be changed in the Preferencessection. 

Reading Ensembl schema databases

The Ensembl project has created public MySQL databases of annotated genomes for many 
species - at time of writing this list includes human, mouse, mosquito, rat, zebrafish, and fugu. 
Each species is stored in a separate, publicly accessible database. The Ensembl adapter can 
read these databases, as well as any other ensembl-schema MySQL database. The Ensembl 
project's databases are at ensembldb.sanger.ac.uk, port 3306, accessible as user "anonymous". 

To directly read Ensembl databases, use the File->Open menu as usual, and choose "EnsJ - 
Direct Access for Ensembl Databases (Schema 32 and above)" from the pulldown (note that it 
may freeze up briefly as it sets up its configuration). 

The EnsJ adapter is initially set to retrieve data from the Homo sapiens database at the 
ensembldb site, but because the database name changes frequently, the name that is hardcoded 
in the default Apollo history may no longer be valid. If you have trouble bringing up the EnsJ 
adapter, try removing your Apollo history (.apollo/apollo.history) and restarting Apollo. Note 
that the list of databases may include some with schemas prior to the current one; if you try to 
read data from those, you will probably get an inscrutable error message. 

After selecting a database (if the default one didn't work), you can select a region to look at. 
The "Location" menu allows you to choose a specific gene to view: either by stable id (e.g. 
"ENSG00000187981"), or by specifying a region of the chromosome (e.g. "Coordinate 
System: Chromosome (Version NCBI 35), SeqRegion: Chromosome 6, from 500,000 to 
1,000,000"--choose "chromosome--NCBI35" for the coordinate system, "6" for the seq region 
name, and 500000-100000 for start-end). 

To try out the EnsJ adapter, click the History pulldown list and select one of the pre-set 
regions. The relevant fields will be filled in appropriately, so you can just hit "Ok" at the 
bottom of the window to load the data. 
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Note that if you already had run a previous version of Apollo and thus have an apollo.history 
file in your .apollo directory, the pre-set EnsJ examples may not work right. You can fix this 
by removing .apollo/apollo.history (so that the new default history takes its place) or by filling 
in the spaces in the Data Source panel by hand (see the next subsection). 

Ensembl features are categorised into various types. In order to see any of these types in the 
region you loaded, you must expand the "Types" panel by pushing the "Show/Hide Types" 
button. You will see the following: 

The numbers beside each type (e.g., Genes (34270)) are the number of features of that type in 
the whole Ensembl database. Select the types of features you want to see ("Genes" is a good 
starting point). You must select something from this panel. At this point you should be ready 
to read data with the default data source configuration (human data at the public servers on 
ensembldb). You can hit the "OK" button on the dialog, and Apollo will bring up the selected 
annotations in your chosen region. 

The "Types" button beside each feature type (eg "Gene Types...") will show a list of the 
different types of genes in the Ensembl database. For instance, in the homo sapiens database, 
there are many types such as protein_coding_KNOWN_ensembl and 
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pseudogene_NOVEL_ensembl. These types can be loaded individually by selecting them 
from this list which is sorted alphabetically. If no types are selected, all types will be loaded. 

Data Source Configurations

The Databases panel specifies where the ensembl database lives, and how to access it. We 
have set it up with some defaults, which should allow you to read human data "out of the 
box", but you might want to read ensembl data from some other species, or set up your own 
ensembl databases. 

Host: The name of the host on which the ensembl databases live. The publicly accessible site 
(ensembldb.sanger.ac.uk) is defaulted in this field. If you set up your own ensembl database, 
or can see another ensembl database nearby, then you will change this field. 
Port: The port on which the database is "listening" for requests. For MySQL, this port is 3306 
by default. 
User: Who Apollo should log in as. The databases on ensembldb all have "anonymous" as the 
user. 
Password: The public ensembl databases on ensembldb have no password for the user 
"anonymous", so you can leave this field blank. 
Ensembl Database Name: This dropdown is only populated when you attempt to open it. It 
shows all the ensembl databases available on the selected host. You, the user, must make an 
appropriate choice in this field appropriate to the value of the "Data Source" dropdown. We 
have defaulted the database to the current human core database 
("homo_sapiens_core_32_35e" at time of writing). 

Please note: the set of available ensembl databases is constantly changing, and your history 
may include databases that are no longer available, which can make the EnsJ adapter refuse to 
come up. If this seems to be happening to you, remove your ~/.apollo/apollo.history and try 
restarting Apollo. 

Loading and saving manual annotations - otter format

This functionality is still being redeveloped for the new EnsJ adapter. 

Reading cross-species comparative data

The still-under-development Synteny viewer in Apollo lets you view comparative analyses 
between two genomes. There are several ways to read synteny data; currently, the default is 
GAME synteny, for which a pair of example files has been included with the Apollo 
distribution. Please see the GAME Synteny user guide for more information. 

Reading GenBank or EMBL format

Apollo can now read GenBank and EMBL format from files or directly over the network 
(given an accession number). GenBank format looks like this: 
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LOCUS       AY308719                1036 bp    DNA     linear   VRT 31-MAY-
2004
DEFINITION  Parus elegans mindanensis FMNH 357569 cytochrome b gene, 
partial
            cds; mitochondrial gene for mitochondrial product.
ACCESSION   AY308719
...
FEATURES             Location/Qualifiers
     source          1..1036
                     /organism="Parus elegans mindanensis"

EMBL format looks like this:

ID   DME9736    standard; genomic DNA; INV; 7411 BP.
XX
AC   AJ009736;

We are still working on this adapter. In particular, reading as GenBank or EMBL and then 
saving in GenBank format doesn't perfectly preserve everything from the original source. 

When you save in GenBank format, you have a choice of saving in a normal human-readable 
GenBank file (as in the example above) or in tabular format, which is mostly used for 
submitting data to GenBank. If you want to save in tabular format, you must supply a 
directory name, not a file name; multiple files will be saved in the directory. To save in 
human-readable GenBank format, supply a file name. 

Reading raw analysis results

The analysis adapter (called "Computational analysis results" in the data loader menu) is one 
of the newest additions to Apollo; it still is in progress and has many bugs, but we hope to 
have it working better soon. It allows you to import raw analysis results into Apollo, view 
them in Apollo's graphical environment, and choose results to form the basis of curated 
annotations. This can be a good entry point for using Apollo to annotate your sequences, 
particularly if you don't have an easy way to get your data into Chado XML or GAME XML 
format. (However, keep in mind that you are responsible for running your own sequence 
analyses--Apollo does not and will not act as a "back end" and run the analyses itself, because 
they are too system-dependent.) 

Different tabs in the analysis adapter allow you to import various types of analysis results on 
your sequence: 

• BLAST
• sim4
• blat
• FgenesH
• Genscan
• tRNAscanSE
• RepeatMasker 

Each one lets you specify a FASTA file containing the genomic query sequence that was used 
in the sequence analysis, and the tier and type to be used for displaying the data in Apollo. 
Some of the analysis tabs offer filtering/processing options, such as the minimum threshold 
for including BLAST hits. 

At the moment, many of the analysis parsers are not working right. Some of the sequence 
analysis programs, such as BLAT, seem to have changed their output format since the Apollo 
parsers were written. The BLAST and Genscan parsers seem to be the best ones right now. 
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Stay tuned for more documentation and improved performance. In the meantime, if you have 
questions about the analysis adapter, please contact the Apollo mailing list. 

The BLAST parser offers many filtering options. In most cases, you can just leave those 
alone. We hope in the future to reduce the complexity of the options. 

Loading BLASTN results

There are many different variations of BLAST format. The two main flavors of BLAST are 
NCBI BLAST and WU-BLAST. Theoretically, Apollo's BLAST parser should figure out 
which BLAST flavor the input is and parse it correctly; in practice, even minor variations in 
BLAST output syntax can cause the parser to fail. As of August 2005, the parser seems to be 
working pretty well on NCBI BLASTN 2.2.11 output from the NCBI blast server 
(http://www.ncbi.nlm.nih.gov/blast/Blast.cgi). (This link is also available on Apollo's Links 
menu.) 

Select "chromosomes" as the database. You can select an organism or category of organisms 
in the Options section. Be sure the last pulldown list on the first row of the Format section 
says "Plain text". When you save the BLAST hits, be sure to save as plain text (not HTML). 
Note that some Web browsers leave bits of HTML markup in the text even when you ask to 
save as text; another way to save the BLAST results that might work better is to select all the 
BLAST result text in the browser window (some browsers have "Select all" under the Edit 
menu), copy it, and paste it into a plain text file (be sure the lines don't wrap). 

Layering data

Some of the data adapters are able to "layer" features that are from the same genomic region. 
For example, you might have separate files of annotations and evidence in GAME or 
ChadoXML format. Use the "Layer more results or annotations" from the File menu to add 
more features on top of what you've already loaded. This only makes sense if the new data is 
from the same genomic region--if it's from a different region, you will probably get a blank 
popup error box. 

Another popular use of the layering option is to add new analysis results for the current 
region--for example, maybe you BLASTed the currently displayed genomic sequence against 
a new database, and want to see the results displayed along with the other evidence. To do 
this, use the "Layer more results or annotations" command from the File menu, and choose 
the "Computational analysis results" data loader from the pulldown list under "Choose data 
source". 

If you are preparing your own data files for layering, please note that you must identify the 
genomic region (e.g. chromosome arm) in each file (even if you don't include the sequence 
residues), so that Apollo knows where the features go. 

The most common scenario for layering BLAST results is that you've already loaded the 
annotations for some genomic region (say, D. melanogaster 2L:12345-67890); you then 
BLASTN an EST against the D. melanogaster chromosomes (see the section on Loading 
BLASTN results above), and you want to see where it matches your currently loaded region. 
To do this, use the "Computational analysis results" data adapter, and select the BLAST tab. 
The checkbox that says "I used the current genomic sequence (or a portion thereof) as my 
BLAST query" should remain unchecked (the default) and you will not need to enter a 
genomic offset. 
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When you load your BLAST results, Apollo will display only the hits against the currently 
loaded chromosome or chromosome arm (but some of them may be to a different region of 
the chromosome). This capability is still under development and may not work perfectly. Note 
that your region must contain a recognizable chromosome name in order for this to work. If, 
for example, you've loaded data from a GFF file, it may not have a chromosome name. Also 
note that BLAST assumes all query sequences are on the + strand--it doesn't have a notion of 
a query sequence being on the - strand. The hits will therefore all show up relative to the + 
strand of the current region. 

Another thing to be aware of (unless this has been fixed recently) is that the chromosome 
coordinates on the D. melanogaster data from FlyBase don't match the coordinates from 
NCBI, so if you load a Drosophila region and try to layer NCBI BLAST hits, they will not 
show up in the right place--they'll appear somewhat shifted to the 3' end. This is a data 
problem, not an Apollo bug, though there are very likely bugs in Apollo's BLAST parser as 
well. 

If you BLASTed some or all of the current genomic sequence against a database at NCBI, you 
should check off "I used the current genomic sequence (or a portion thereof) as my BLAST 
query." If you used only a portion of the current genomic sequence, enter the offset of the 
sequence you used from the starting position of the current genomic region (we plan to 
automate this offset calculation soon). 

Launching Apollo with command-line arguments

Unix users can launch Apollo on a datafile by using the appropriate command-line arguments. 
Use "--help" to get a list of the options. Valid arguments are: 
  -i (or --inputFormat) input_format    Specify input format. 
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                                        [chadoDB|game|chadoxml|genbank|gff|
backup]
  -f (or --inputFile) filename          Specify filename (or URL) to read 
in 
                                        (game,gff,gb,chadoxml,backup)
  -u, --featureName=feature_name        Specify a feature name for input. 
The type
                                        of name will depend on --inputType
  -l (or --location) location           Specify a location for input. 
                                        Chromosome:start-end, e.g. 
chr1:1000-6000
  -x (or --readGameFile) game_file      Read in a game file or URL.
                                        (Shorthand for -i game -f gamefile)
  -b (or --readBackupFile backup_file)  Read in a backup (serialized) file. 
                                        (Shorthand for -i serialized -f 
serFile)
  -s (or --sequenceFile) sequence_file  Specify FASTA sequence file to load 
with
                                        gff file
  -o (or --outputFormat) output_format  Specify output format. 
                                        [chadoDB|game|chadoxml|genbank|gff|
backup]
  -w (or --writeFile) filename          Filename to write to
  -n, --inputListFile=filename     Specify a file which contains a list of 
items
                                   to query of type inputType. These will 
then
                                   be queried with inputFormat and written 
out
                                   to ouputFormat.
  -k, --skipExistBatchEntry        If in batch mode, skip entry if the 
output
                                   (file) already exists
  -t, --inputType=type             Input type is dependent on input format. 
For
                                   chadoDB use the seqTypes for the db 
being
                                   loaded (e.g. chromosome_arm|chromosome, 
gene,
                                   golden_path_region...
  -U, --readDbUser=db_user         Username for the chado database you want 
to
                                   read from/write to.
  -D, --readDbPass=db_pass         Read in the password for the chado 
database
                                   you want to read from/write to.
  -F, --dbFlatFileOutput           Whether to dump database updates to an 
ad-hoc
                                   flat file format.
  -p, --inputFilesList=filename    Specify a file which contains a list of 
files
                                   to process as inputFormat and to write 
to
                                   outputFormat. Intended for batch loading
                                   files into a DB (chado)
  -? (or --help)                        Show this help message
The command-line arguments changed starting with release 1.5.0, but for now most of the 
older command-line arguments (e.g. "-x" for reading GAME XML files) are also supported. 
The new command-line arguments start with a double dash ("--") if they are not single-letter 
arguments (this is a standard for most Unix commands). Most of the arguments have a long 
form (with a double dash) and a short form (with a single dash). 

Here are some examples of how you can launch Apollo from the command line: 

apollo --inputFormat chadoxml -f ~/apollo/data/CG16983.chado.xml
apollo -i game -f data/example.xml
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apollo -i game -f http://flybase.net/cgi-bin/apollo.cgi?gene=cact
apollo -i gff -f data/chr2.200000-400000.gff -s data/chr2.200000-
400000.fasta
apollo -i game -f data/example.game -o chadoxml -w example.chado

As the last example above shows, you can use the apollo command line to load data from one 
data source and save in a different format, (e.g. load from a chado DB and save in GAME 
XML format, or vice versa) without bringing up the Apollo GUI. Here is an example of 
loading from a chado database and saving in GAME XML format: 

apollo --inputFormat chadoDB --writeFile outfile.game
Note that the information about the specific Chado database is specified in the chado-
adapter.xml config file rather than on the command line. Also, the "--outputFormat" argument 
is not needed because Apollo can figure out from the ".game" suffix that the file should be in 
GAME XML format. 

Writing your own data adapter

If you are a software developer and would like to write a new data adapter for Apollo so it can 
read and/or write a different data format, please see the Data Adapter Cookbook. Writing a 
new data adapter is nontrivial but doable. Also see the section in this document on Adapting 
Apollo. 

Styles

Apollo has a configuration file for each known data source. This file is known as a "style" 
file. When you choose a data source, Apollo automatically selects the right style file to help it 
display the data appropriately. If you want to change some of the display parameters (e.g. the 
background color, names of data types, etc.) be sure to change the appropriate style file--e.g. 
the style file for the Drosophila data is called fly.style. By default, the style files all live in the 
conf directory. See the section on configuration files for more about what's in style files and 
how you can change it. 

The display panels

The main window

When Apollo has loaded the data for the region you selected, the main window will appear. 
Below, for example, the main window is displaying a portion of Drosophila chromosome arm 
3R (but note that this is not current data). The top panel graphically displays the results and 
annotations. The scale (in base pairs) goes across the middle of this panel. All forward strand 
features are shown above the axis and reverse strand features are below the axis. Each feature 
type can have a different color. For instance, for the Drosophila data shown in the example 
below, annotated genes are blue, Genscan predictions are lavender, and BLASTX similarities 
to fly sequences are red. 
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The feature types are grouped into tiers, conceptual groupings of related types that can be 
controlled as a unit and displayed in a single horizontal row. 

Annotations vs. results

Each of the colored boxes in the main panel is a genomic feature. At the most basic level a 
feature consists of start and end coordinates on a piece of genomic sequence. Much of the data 
we deal with can be organized into groups of features that we call feature sets. For instance, a 
gene is made up of a set of exons which are represented as a group of features. The exons 
belonging to a particular gene are joined by lines. 

When you display Drosophila data, the main panel has a light blue region and a black region 
both above and below the central axis. The black panels show the raw computational results 
that were obtained by running various analysis tools (GENSCAN, BLAST, etc.) on the 
Drosophila genome. The light blue panels closer to the axis show the annotations that were 
assigned by the biologists who studied all the results and decided where the genes and other 
important genetic features (e.g. transposons) are located. The Ensembl human annotation data 
is different--it has not been hand-curated, so there is no distinction between "results" and 
"annotations". 

The thin green and red vertical lines crossing the axis indicate the limits of the sequence in the 
current range. Outside of this region, you will not see the DNA sequence when you zoom in. 
Also, some editing functionality is not available for annotations outside of the zone that has 
sequence. 

Splitters

46



The little red triangles on the left side of the main window are called splitters. They allow you 
to control the amount of real estate devoted to the annotation and result panels on each strand. 
Drag the triangles up or down to adjust the panels. 

To reset the panels to their original sizes, use the "Reset views" menu item in the View menu. 

You can also adjust the horizontal size of the evidence panel on the left side of the main 
window by dragging the vertical drag bar. 

Zooming and scrolling

To zoom in for a closer view, use the x2 and x10 buttons. To zoom out, use the x.1 and x.5 
buttons. When you've zoomed in as far as you can go, the x10 and x2 buttons will become 
disabled. (You wouldn't want to zoom in any further than that, anyway; you can already see 
the individual bases at that zoom level.) You can reset to the original zoom level with the 
"Reset" button. 

To scroll horizontally, use the scrollbar just above the zoom buttons. The main panel also has 
vertical scrollbars--if there are many different results or annotations stacked up, you may need 
to scroll vertically to see all of them. If you have a middle wheel on your mouse, you can use 
it to scroll the panels vertically. 

Moving using the mouse--centering the display

Often you want to center the panel on a feature and zoom into that feature. Clicking the 
middle mouse button anywhere in the main panel will center the panel around that point. If 
you now press the zoom buttons, you will stay centered around the selected position as you 
zoom in or out. 

To move using the middle mouse button you can middle-click at the left or right sides of the 
main panel which will recenter the panel at that position and move the display by half a 
window. 

If you are on a PC or Mac, please see the summary of mouse functions for a discussion about 
how to simulate right- and middle-mouse clicks. 

Zoom to selected

The "Zoom to selected" function zooms and centers the display so that the currently selected 
item(s) fill the entire view. This function is in the View menu; its keyboard shortcut is ctrl-z. 

The guide line

To turn on the "guide line", check the "Show guide line" checkbox in the View menu. A black 
vertical line will appear at your current location. If you scroll, the line will move with you, 
helping you to remember where you were. If you Zoom to selected, the guide line will reset to 
the selected location. 

Forward and reverse strands

Sometimes having both the forward and reverse strands visible takes up too much space, 
making it harder to see all the features. To toggle strands on and off, use 'Show forward 
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strand' and 'Show reverse strand' in the View menu. The keyboard shortcut for Show/Hide 
Forward Strand is ctrl-f; the keyboard shortcut for Show/Hide reverse strand is ctrl-r. 

Showing reverse complement

To avoid thinking backwards when looking at features on the reverse strand, the whole 
display (including the sequence) can be reverse complemented. To do this select the 'Reverse 
complement' option in the View menu. When the display is reverse complemented, the axis 
numbers turn red as a reminder. There is also a shortcut for performing a reverse complement: 
simply type the letter 'r' with your cursor over the main window. 

"Flip strands" does a reverse complement if both strands are currently displayed. If you were 
showing only one strand, "Flip strands" will show you the other strand, reverse 
complemented. This allows you to look at the reverse strand above the axis, so you don't have 
to turn your computer upside-down. 

Inverting tier order

If you type "o" with your cursor over the main window, or use the "Invert tier order" 
command in the Tiers menu, each panel will invert from top to bottom. This is not the same as 
flipping strands--each strand stays where it was; only the vertical position of the features in 
each panel is flipped. 

Feature detail panels

If you click on a feature or features, it is selected (boxed in red) and more information about it 
will be displayed in the detail panel at the bottom of the main window. The left side of the 
detail panel shows the type of feature and its name, sequence range, and score. The bottom 
right panel displays the coordinates of the selected features and possibly other information as 
well, depending on the feature type. 

Each feature set only appears once in the lefthand panel so selecting a feature name in that 
panel may display a number of features in the right hand display. For instance, if our genomic 
sequence has hit protein P33674 ten times we will only have one entry in the lefthand panel 
but selecting it will display ten rows in the righthand panel. 

Preferences

The Preferences editor can be accessed from either from the Edit menu (Edit->Preferences) or 
by choosing Preferences from the popup menu when right-clicking on a feature (the later will 
bring up the Preferences Editor with the Types panel selected and the configuration for the 
feature clicked on selected as well). It can be used for setting up some of the more useful 
settings for Apollo Style and Tiers files through a simple GUI. The Preferences editor 
replaces the old "Style Preferences" editor (which was basically just a text editor requiring the 
user to know what are the valid key/value pairs) and the Types panel. Note that it only 
supports a subset of all the configurable options for style/tiers files. This subset should suffice 
for most users, but power users can always manually edit those files (as was done in previous 
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versions of Apollo). See Style files and Tiers files for more specific information about all 
supported options.

The bottom of the editor provides 3 buttons: 

• Preview
o Allows you to preview the changes made before actually applying the changes 

permanently.
• Cancel

o Cancels any changes made, reverting all changes to the previous states.
• Save

o Brings up a dialog for choosing where to save the configuration changes. If 
Style is the currently selected tab, it will ask where to save the new Style file. 
If Types is the currently selected tab, it will ask where to save the new Types 
file. In both cases, a suggested file name will be provided, defaulting to storing 
to the ".apollo" directory in your home directory. Note that if you override the 
suggested name for the Types file, Apollo will ask you to save the Style file as 
well (as the Style file needs to be updated to use the new Types file).

The Preferences editor offers two panes to choose from:

Style
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The Style editor offers the following options:

• Tiers file
o Displays the tiers file that is associated with this style. It cannot be changed 

manually. It will get updated automatically if you save the tiers file to another 
file.

• Enable annotation editing?
o If checked, allows annotations to be edited.

• Annotations
o Show

 If checked, display annotations.
o Background color

 Select the background color for the annotation tracks.
o Label color

 Select the label color for annotations.
o Note that changing the label color will affect the label color in both 

background/label buttons. Similarly, changing the background color will affect 
the background color in both background/label buttons. This allows you to get 
an idea of what the colors will look like.

• Results
o Show

 If checked, display results.
o Background color

 Select the background color for the result tracks.
o Label color

 Select the label color for results.
o Note that changing the label color will affect the label color in both 

background/label buttons. Similarly, changing the background color will affect 
the background color in both background/label buttons. This allows you to get 
an idea of what the colors will look like.

• Canned annotation comments
o Editable list of annotation comments used with the Annotation info editor.

• Canned transcript comments
o Editable list of transcript comments used with the Annotation info editor.

Types

50

http://apollo.berkeleybop.org/current/userguide.html#AnnotationInfo
http://apollo.berkeleybop.org/current/userguide.html#AnnotationInfo


The Types editor offers the following options:

• Tier
o Dropdown list of available tiers. Click the "New" button to create a new tier. 

Changing the selected tier will update the display with the settings for that tier.
o Visible?

 If checked, features in that tier will be visible.
o Labeled?

 If checked, features in that tier will have their labels visible.
o Expanded?

 If checked, all features in that tier will be displayed. If not checked, 
overlapping features will be collapsed onto one another.

• Drawing group
o Dropdown list of available drawing groups for the currently selected tier. Click 

the "New" button to create a new drawing group. Changing the selected 
drawing group will update the display with the settings for that drawing group.

o Shape
 Dropdown list of available shapes for the selected drawing group. 

Supported shapes are:
 DrawableGeneFeatureSet
 DrawableResultSet
 DoubleHeadedArrow
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 Triangle
 Zigzag
 ThinRectangle.

o Match UTR color to background?
 If selected, will match the UTR color to the background color, giving it 

a "transparent" look. Only applicable if the shape is 
DrawableGeneFeature. Will be disabled if another shape is selected.

o Color
 Select the color for the selected drawing group.

o Scale height by score?
 If selected, features with higher scores will be drawn taller than 

features with lower ones.
o Minimum score for scaling height

 Minimum score for scaling height.
o Maximum score for scaling height

 Maximum score for scaling height.
o URL

 URL for linking out this drawing group.
o Apply to following data types

 Editable list of feature types that belong to this drawing group.
o URL

 URL for linking out this drawing group.

Apollo windows

The "Window" menu in Apollo helps you keep track of the various Apollo windows that are 
open (such as the Types window). You can bring an Apollo window to the top by choosing it 
from the Window menu. 

Apollo and Web browsers

Some Apollo commands (such as "Help" and "Get info about this feature via Web") direct 
your Web browser to bring up a particular Web page to show the requested information. 
Apollo tries to guess which Web browser you use. On Windows or Mac, it will bring up your 
default web browser (typically Internet Explorer on Windows or Safari on Mac). 

On Unix (Linux/Solaris), the situation is a bit more complicated: there are many versions of 
Netscape and Mozilla, each of which behaves differently. (On Solaris, for example, it no 
longer seems to be possible for Apollo to open a new Netscape--you must already have 
Netscape running in order for Apollo to access it.) We have tried to make Apollo make 
intelligent guesses about how to address your Web browser, but if it doesn't seem to be 
working right, you can explicitly add your Web browser path to your apollo.cfg file. To do 
this, you can edit the apollo.cfg that lives in the conf directory under the directory where you 
installed Apollo, or you can create a directory in your home directory called .apollo and create 
a new file there called apollo.cfg. The line you need to put in apollo.cfg specifies the path of 
your browser program: 

BrowserProgram          "/usr/local/bin/mozilla"
(substituting the appropriate path of your web browser). 

Selection

Selecting a single feature
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Selecting one feature is as simple as clicking on that feature. You will know it's selected as it 
will have a red outline around it. Selected features are described in the detail panels at the 
bottom of the main window. 

Selecting multiple features

You can select more than one feature using the the mouse by pressing the middle button and 
dragging the mouse around the features you want to select ("rubberbanding"). (If you are on a 
Windows or Mac platform, please see the summary of mouse functions for a discussion about 
how to simulate middle-mouse.) When you release the mouse, there may be a brief pause; 
then all the selected features will be outlined in red and they will all be listed in the detail 
panel. 

The shift key can be used to toggle features in or out of the selection. You can add features to 
the currently selected set by shift-clicking with the left mouse button (to add single features) 
or shift-middle-mouse-dragging (to add multiple features). To deselect one or more of the 
features you have selected while leaving the others selected, shift-click (or shift-middle-drag) 
the feature(s) you want to deselect. 
Mac users please note: there are Java bugs on Mac that make the rubberbands behave badly. 
If you are running an older version of Mac OS X, you may notice a rubberbanding bug where 
the black rubberband rectangle is redrawn as you move the mouse, instead of just at the end 
when you release it, so you will see a concentric set of black rectangles. On some version of 
Mac OS X, the rubberband may be slow and thick. These are bugs in the JDK, not in Apollo. 

By default, the selected features are sorted by start position (Range) in the detail panel on the 
lower left. You can change the sort by clicking (for forward sort) or shift-clicking (for reverse 
sort) on a column header. For example, clicking on "Name" sorts the selected features in 
alphabetical order by name, and shift-clicking on "Score" sorts them in descending order by 
score. 

If you click on an intron, the whole transcript is selected. Double-clicking an exon also selects 
the whole transcript (all exons connected to the one you double-clicked). Double-clicking an 
intron belonging to a result selects all results of that particular type. 

Adding to a selection

If the features you want to select are in multiple places, holding down the shift key before 
selecting them will add to the previous selection. If you don't hold down the shift key when 
selecting new features, any previous selected features will be automatically deselected. You 
can use the shift key with left mouse (to add individual features to the selected group) or with 
middle mouse (to rubberband more features). 

Deselecting

If you click on the background of the main panel, any features selected in red will be 
deselected. However they will still be shown in the feature detail panels. 

Finding out more about annotations and features

If you select a feature and click the right mouse button, a popup menu will appear. Many of 
the functions described in this section are accessed via the right-mouse popup menu. Please 
see the section on mouse functions for a discussion of how to simulate right-mouse on various 
platforms. Also note that it matters where your cursor is when you hit the right mouse button; 

53

http://apollo.berkeleybop.org/current/userguide.html#MouseFunctions
http://apollo.berkeleybop.org/current/userguide.html#MouseFunctions


in particular, you must have your cursor in the same strand as the selected features in order to 
perform functions on those features. 

Get info about features via Web

Many features originate from other databases (e.g. SwissProt, EMBL, Ensembl, GenBank) 
and we can learn extra information by looking up those features in their parent databases. To 
load a web page with more information about a feature, select the feature in the main panel, 
right click on it, and use the right menu option 'Get info about this feature via Web'. If an 
URL for this feature type has been registered in the types file, a Web page showing 
information about this feature will be brought up. For instance, selecting a sequence from 
GenBank will take you to the report for that accession at GenBank. 

It can take a while for the new Web page to appear, as the information has to be sent over the 
network. If your Web browser window was iconified or hidden, you may have to bring it back 
up to see the new information. 

Apollo sometimes has trouble figuring out how to talk to your Web browser. Please see the 
section on Apollo and Web browsers for more information. 

Annotation info

The "Annotation info" popup menu item brings up a window that has text information about 
the annotation. (If you have editing enabled, it will also allow you to add or change the text 
for an annotation.) 

Comments and properties associated with the annotation are shown in the scrollable 
"Comments" panel, followed by comments and properties associated with individual 
transcripts belonging to the annotation. 
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Above the "Comments" panel is a table listing database ID(s) for this annotation. If you select 
an ID, more information about that database entry (if available) will appear in your Web 
browser. You can also add or delete an ID. When adding an ID, the following window will 
appear:

Note that "ID" and "Database" are in red. These are required fields. The other fields are 
optional. Click "OK" to make the changes or "Cancel" to discard them. 

The "Follow selection" checkbox on the lower left side of the window is used to follow 
selections from other parts of Apollo. If it is checked, then when you select another annotation 
in the main Apollo window, the annotation info window will load that annotation, and if you 
select an annotation name in the annotation info window, the main window will scroll to show 
that annotation. 

You can have multiple annotation info editors open at once. If you make your changes in one 
editor, the annotation info for that annotation will automatically get updated in all other open 
editor windows. 

You can browse comments for each annotation by using the Annotation Tree at the left side of 
the Annotation info panel. By checking "Follow external selection", you can select different 
annotations in the main window by clicking on their names in the Annotation info panel. The 
behavior is the same as the Annotation Tree window described below. 

The Annotation Tree
The Annotation Tree window 
provides an alternate way to 
explore the annotations. You 
can bring up the Annotation 
Tree from the View menu. 
(Starting in version 1.4.0, the 
annotation tree is also 
integrated into the Annotation 
Info editor.) Annotations are 
listed in the left-to-right order 
in which they appear in the 
current region. 

Click on an annotation name to 
scroll the main window to the 
beginning of that annotation. 
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Double-clicking the annotation 
name will scroll the main 
window to the end of the 
annotation. After making an 
initial selection in the 
annotation tree by clicking on a 
gene name, you can use the 
arrow keys on your keyboard 
to navigate up and down the 
tree. If you right-mouse click 
over a gene name in the 
annotation tree, a menu item 
lets you bring up the annotation 
info window for that gene (if 
you weren't already in the 
annotation info window). 
If you click on the + icon to the 
left of an annotation name, that 
item will expand to show all 
the transcripts for that gene. 
Clicking the + to the left of a 
transcript will show you the 
coordinates of the exons for 
that transcript. You may also 
be able to use the right and left 
arrow keys on your keyboard (-
> and <-) to expand and close 
nodes in the tree. 

Mac users please note: On a 
Mac, you will see horizontal 
and vertical arrowheads instead 
of + and -. To open or close a 
node, you must click on the 
base of the arrowhead, not the 
pointy end. 

Annotation menu
You can also select a gene or other annotation of interest from the Annotation menu, which is 
sorted alphabetically by name and colored by annotation type. If the annotation name is in 
bold italics in this menu, it means that the annotation is unfinished. When you select an 
annotation name, Apollo will zoom to show that annotation plus a window on each side. 
Please note that sometimes Apollo fails to scroll vertically to the selected annotation (this is a 
known bug). 

Bookmarks

Apollo allows you to bookmark genes of interest so you can easily come back to them. Select 
a gene transcript and use Bookmarks -> Add bookmark. To revisit a gene, select its name 
from the Bookmarks menu. The resulting view is as if you had selected the gene from the 
Annotation menu, as above.
 
Search functions
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Finding a specific base

If you know that your feature is at a specific base pair in the sequence you can use the find 
function to go straight to it. From the Edit menu choose Find and a window will be displayed. 

Entering a base pair coordinate in the Position field and pressing Goto will center the main 
panel display on that base pair. 

Finding a feature

If you have loaded a genomic region and you know a gene or a protein exists in there 
somewhere but you're not sure where, you can enter an accession or gene name in the Name 
field. Pressing Find will search through all the features looking for one with that name. If one 
(or several) are found they will be selected and the main panel will be centered on them. 
Search is case-insensitive. 

The search by name adds an implicit wildcard (*) to the end of your search string. It will first 
look for a feature with the exact name you specified (e.g. LD46133). If nothing with that 
name is found, it will look for features whose names begin with that string (e.g. it might find 
LD46133.5prime). We plan to add more flexible handling of wildcards soon; for now, your 
search string should contain only the actual characters you're looking for. 

Finding a subsequence

To search for occurrences of a DNA sequence in the current genomic region, enter it in the 
Sequence field on the Search window. All occurrences of that sequence found on the selected 
strand will be displayed in a table. Selecting an entry from this table will zoom to show you 
the matching subsequence next to the axis. 
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Using regular expressions

If you check the "Use Regular Expresions?" box, you can search for a sequence or a feature 
name that matches a pattern. Regular expressions are a way of specifying these patterns. 

There is not space here to describe all the things you can do with regular expressions, but here 
is a simple example: the user wants to find all subsequences that start with AAA, end with 
TTT, and have a run of C's and/or G's (in any order) in the middle. The regular expression for 
that pattern is 

AAA[CG]+TTT
A group of characters inside the square brackets means "any of these", and "+" means "one or 
more instance of the preceding expression". Here are the results of that search: 
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Regular expressions can also be very useful when looking for features with a certain name--
for example, if you are looking for an EST whose name starts with SD, you could search for 
"^SD.+" ("^" means that the pattern must match the beginning of the name; "." means any 
character). 

Keep in mind that regular expression matching is "greedy", meaning that it tries to match the 
longest string it can. So if you were, say, looking for the pattern "ATCG.*GGAC" in order to 
find sequences flanked by ATCG and GGAC, it might find a huge match because the string 
ATCG happened to be found near the beginning of the genomic region and GGAC happened 
to be found near the end, and then it wouldn't find any shorter matches in the region. To 
prevent this from happening, you can specify the minimum and maximum values for a *--e.g. 
"ATCG.{0,20}GGAC", which would find sequences flanked by ATCG and GGAC with up to 
20 bases in between. 

Specifying which features to display

There can be many features on a piece of genomic sequence and the user may not want to see 
all of them all at once or maybe not in the maximum amount of detail. Apollo allows the user 
to control the level of detail that is used. 

Collapsed view

In this view all the features are displayed but all the features belonging to a single tier are 
placed on the same line. Therefore at any one point there may be several overlapping features 
piled on top of one another. This can be useful in a zoomed-out view so the user can see at a 
glance the rough areas of genomic sequence that have features associated with them. Since all 
the features are displayed in one row, screen space is conserved and more feature types can be 
seen at once. 

Collapsing a specific feature type can be done in two ways. The user can select one of the 
features and right-click on it. A popup menu will come up and selecting the 'Collapse tier' 
option will force all features of that type to be drawn on one line. The other way to collapse 
features is to bring up the Preferences editor and uncheck the 'Expanded' checkbox for the 
desired feature type. To collapse all tiers, use the "Collapse all tiers" option from the Tiers 
menu. 

Expanded view

When zoomed into a region, features often need to be seen in more detail. The expanded view 
arranges all the features so none of them overlap. This is essential when looking in more 
detail at the possible exon/intron structure implied by BLAST hits and for possible alternative 
splicing structures. To expand the view of a feature type, select a feature of the type you want 
to expand and right click. Select the 'Expand tier' option and all features of that type will be 
drawn non-overlapping. To expand all tiers, use the "Expand all tiers" option from the Tiers 
menu. 

The image below shows the same set of features as above but now the red and orange BLAST 
hits are expanded. 
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Hiding features

There are often features that you're not interested in that take up valuable screen space. These 
can be hidden from view until you need them. Select a feature of the type you wish to hide 
and right click. Select the 'Hide tier' option from the popup menu and the features of that type 
will not be drawn. This can also be done via the Preferences editor --just uncheck the 
'Visible?' checkbox for the relevant feature type. 

If you want every feature to disappear, select "Hide all tiers" from the Tiers menu. 

Showing features

If you want to reshow hidden features either use the Preferences editor and click the 
"Visible?" checkbox, or right click in the result background. Select the 'Show tier' option from 
the popup menu and select the tier you want to show again. To turn on all tiers, select "Show 
all tiers" from the Tiers menu. 

Changing color of a feature type

To change the color of a feature type, you can use the 'Change color for this feature type' 
option in the right mouse popup menu, or you can use the Preferences editor. If you change 
the color through the first method, the color change is only temporary to the current Apollo 
session, unless you save it via the the "Save type preferences" menu item in the File menu. 

Resizing features

The height of all the features can be increased or decreased with the "Increase tier height" and 
"Decrease tier height" options in the Tiers menu. The keyboard shortcuts for these commands 
are "+" and "-" (don't use the control key--just + or - by itself). 

Showing sequencing gaps in ESTs

By default, sequencing gaps in EST results are shown as dashed lines. This is controlled by 
the DashSets option in the appropriate style file. The color of the dashed lines is set by the 
SequenceGapColor setting in the style file. 

Hits to new sequences

If a result type has a date defined in the tiers file, then results of that type that represent hits 
(homologies) to sequences newer than that date are shown with a box around them (in the 
edgematch color). 
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Showing feature labels

By default, annotations are labeled with their names, and other features are not labeled. To 
turn on labels for a particular feature type, bring up the Preferences editor (Edit->Preferences) 
and check the 'Labeled?' box for the feature type of interest. 

At low zoom levels the labels may overlap so they are hard to read. At high magnifications 
the labels are organized so they don't overlap each other. (You can turn off this behavior by 
unchecking the "Avoid text overlaps" box in the View menu.) 

Background colors

The startup background colors for both portions of the main panel (Results and Annotations) 
can be set in the style file--see the Configuring Apollo section. Once you have launched 
Apollo, the background color of the result panel can be inverted by choosing "Invert result 
background color" from the View menu. You can change other colors with the Preferences 
editor. 

Changing orientation of evidence panel

The evidence panel that shows details about the currently selected features comes up by 
default in a vertical orientation at the left side of the main window. If you prefer this panel to 
be oriented horizontally, select the "Make evidence panel horizontal" option from the View 
menu. You can also set this option in the apollo.cfg file (the option is called 
FrameOrientation). 

Sequence level features

By sequence level features, we mean features that only need to be displayed at the base pair 
level--start and stop codons and of course the sequence itself. This section describes ways to 
look at features at this level of detail.

Showing the genomic sequence

If you're fed up with colored boxes and want to go right down to the genomic sequence, you 
need to zoom in far enough so there is room for the individual bases to appear near the axis. 
The forward strand bases appear above the axis, and the reverse strand bases appear below the 
axis. If the sequence is currently reverse-complemented, the axis and base numbers are shown 
in red. 

You can use the middle mouse button to rubberband a region of sequence immediately above 
or below the axis; the selected sequence will pop up in a new sequence window (unless you 
have selected too big a region). You can then copy from the sequence window and paste into 
another application (e.g., a primer predictor), if desired. If you have selected a very large 
region, you will be prompted to enter a filename to save the sequence as a FASTA file--you 
won't see it displayed in a sequence window. 
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If you select a feature in the main panel, the region of sequence corresponding to that feature 
will be highlighted in the feature's color. If you click your right mouse button near the axis, 
you will be offered another option: "Color bases by splice site potential". This uses a two-
color system for indicating splice site potential: GT is colored orange and AG is blue. Note 
that when you are in splice site coloring mode, selecting features won't highlight them in color 
on the sequence. To get that behavior back, right-mouse near the axis and select "Color by 
selected feature". 

The features that have sequence associated with them will also show their sequence when you 
have zoomed in enough. Protein features (such as annotations) show their translated amino 
acid sequence, while other features show their DNA sequence. 

Please note that the sequences you see inside the result features do not represent actual 
sequence alignments. If the alignment between the result and the genomic sequence includes 
insertions in the result sequence, the corresponding gap(s) will not appear in the genomic 
sequence, so the result residues will not be lined up correctly with the genomic sequence. In 
order to see the correct, gapped alignment between results and genomic sequence, use 
Jalview. 

If the sequence letters are too tall to fit in the features, you can type '+' while over the main 
panel in order to increase the height of the feature rectangles. Sometimes if a feature is 
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partially covered up, its sequence doesn't show up--you can get the sequence to show up (if 
the feature indeed has sequence associated with it) by clicking on the feature of interest to 
bring it to the foreground. 

Viewing, translating and saving sequence for selected features

If you want to see the sequence of one or more features, select the features and then use the 
"Sequence..." option on the right-mouse popup menu. (If "Sequence..." is grayed out, it means 
you haven't selected any features that have sequence associated with them.) You can also use 
"Open new sequence window" from the View menu. 

The sequence window lets you translate the sequence to amino acids or view the virtual 
cDNA sequence (just the exons) or the coding sequence (from start of translation to stop). The 
default display is amino acid sequence for gene annotations and result sequence for results 
that have sequence. Click the "Save as..." button to save the currently displayed sequence(s) 
as a multiple-FASTA file. 

By default, the sequence window does not follow selections made in the main panel. To 
change this, you can check the "Follow external selection" checkbox. Then if you select new 
features in the main panel, their sequences will show up in the Sequence window. You can 
launch a new sequence window directly from an existing one by clicking the "New sequence 
window..." button. 
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Please note that annotations at the very edges of the region you are looking at may be mostly 
outside the region (they are included in the region if they have even one base inside the 
region), in which case you won't see their translations as you zoom in and the Sequence menu 
item will be disabled. 

Saving whole sequence

The "Save sequence" menu item (in the File menu) lets you save the entire sequence of the 
current region as a FASTA-format file. 

Start and stop codons

If Apollo has sequence loaded and you zoom in far enough, start and stop codons will be 
displayed in all six frames. The start codons are shown in green and the stop codons in red. If 
you are viewing a region downloaded from an Ensembl database, Apollo will fetch the 
sequence from the database so it can calculate the positions of the start/stop codons. 

When you select a whole transcript in the annotation panel and the start and stop codons are 
visible, the codons that correspond to the start and stop of translation for that transcript will be 
highlighted (boxed in red). Note that, at the moment, if you only select one exon, you will not 
see the start and/or stop codons used in that exon boxed in red. We hope to fix that soon. 

You can change the stop position in a transcript by selecting one of the stop codons in the 
start/stop zone and dragging it onto the transcript. 

Showing edge matches

To help you to compare different features in detail, all features that have the same 5' or 3' 
boundary as the currently selected feature are highlighted with white lines at the edges of the 
feature boxes. For example, in the screenshot below, the user has selected several purple 
exons; the edges in other features that match the edges in the purple exons are colored white. 

Edge match highlighting is enabled by default. You can turn it off by unclicking "Show edge 
matches" in the View menu. The color and width of the edge match highlighting can be 
controlled by options in the style file. 

Non-consensus splice sites

To help you identify splice sites that are unconventional, colored triangles appear in the 
annotation glyph. In the example below, the unconventional splice donor (not GT) is indicated 
with an orange triangle pointing to the left, and the unconventional splice acceptor (not AG) is 
indicated with an orange triangle pointing to the right. 
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To mark a non-consensus splice site "approved", bring up the annotation info editor on that 
transcript, and check the box that says "Approve non-consensus acceptor [or donor] in exon 
k." 

Untranslated regions (UTRs) in a protein-coding gene are indicated with transparent boxes; 
the 5' UTR is upstream of the start codon, indicated in green, and the 3' UTR is downstream 
of the stop codon, indicated in red. The color of the UTRs can be set by the user in the tiers 
file. 

Analyses: GC content and restriction sites

If the region you are looking at has sequence associated with it, you can show a graph of GC 
content or find restriction sites. Note that GFF files generally don't include sequence. 

Showing a GC graph

Selecting "Show GC plot" from the Analysis menu will cause a graph of GC content to be 
displayed below the axis in the main panel. As with the start and stop codons, if you retrieved 
features from an Ensembl database, Apollo will go back to the server to retrieve the sequence, 
since it needs the actual base pairs in order to calculate GC content. 

The GC analysis control window allows you to adjust the window length and the color used 
for the plot. 

Showing restriction sites

If you choose "Find restriction sites" from the Analysis menu, the analysis control window 
pops up with a list of restriction enzymes. You can choose one or more of the restriction 
enzymes (use the control key to add to your selection). 

The colors of the different restriction enzymes are chosen randomly each time. If you don't 
like the colors, kill the Analysis window and bring up a new one. 

When you click "Digest", you will see the restriction enzyme sites near the central axis. 
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Note that if you've selected more than one restriction enzyme to map, scrolling (or any 
operation that requires the Apollo window to redraw) may become very slow as Apollo 
struggles to redraw all the restriction sites. 

The restriction enzyme selection window shows a table listing the positions and sizes of the 
restriction fragments resulting from your digest. 

If you click on one of the fragments in the table, the main window will highlight the fragment 
sequence and zoom to the beginning of it. 

If you check any "Select" boxes and then click "Show selected sequence fragments", the 
selected restriction fragment sequences will pop up in a sequence window. 

Viewing alignments

To let you examine the alignments between different features and the genomic sequence, 
Apollo has an interface to the Jalview multiple alignment viewer. 

Jalview is invoked by choosing one or more features (results and/or annotations) and selecting 
"Align selected features" or "Align same type features in region" from the right-mouse popup 
menu. "Align selected features" will align just the features you have selected. "Align same 
type features in region" will align the selected features plus any features that are the same type 
as any of the selected features and are within the same range (between the lowest and highest 
base pair in the selected features). 

The selected sequences that qualify will come up in Jalview along with four additional 
sequences: the genomic sequence plus its three-frame translation. 
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Jalview can display DNA and/or peptide sequences. Amino acids are shown as single-letter 
codes followed by two spaces. 

Jalview only displays features from one strand, the strand from which you invoked the popup 
menu. If there are no features selected on that strand the menu item will be disabled. 

In the Drosophila (GAME XML) data, some results have alignment sequence and some do 
not. Features that don't have sequences of their own come up with their corresponding 
genomic sequence, in which case you will see only the trivial and uninformative genomic-to-
genomic alignment. Sometimes it's useful to include some of these features in order to 
compare them with real alignments. 

Ensembl data currently does not have alignment sequences that are accessible externally. This 
means that at present, if you use Jalview on Ensembl data, you will see only the 
corresponding genomic sequence for all the results, which is not very informative. We hope 
that this will be fixed soon. 

Features that are not entirely within the range of the entry currently loaded (overhangers) will 
not be displayed in Jalview, as there is no genomic sequence to align them to. 

Sequences in Jalview can be selected by clicking on the sequence label on the left and 
deselected by clicking them again. Selected sequences can be removed from the alignment 
display by selecting "Delete selected sequences" from the Edit menu. "Invert sequence 
selection" will deselect all currently selected sequences and vice versa. 
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When you select a feature that has introns, or two or more features that do not overlap, 
Jalview displays them with gaps (dashes) between them. It does not display all of the genomic 
sequence of introns or gaps between features. It does show 9 or 10 bases of genomic sequence 
on both sides of the intron. This is so the user can see sequence relevant for splice sites. 

"Edit->Removed gapped columns" will remove the gapped columns (all dashes). So this will 
remove the gaps of the intron, but the genomic sequence of the intron remains. On our todo 
list is adding a menu item to remove the whole intron, gaps and genomic. 

Columns can be selected/deselected by clicking above the sequences. A red square will 
appear in the selected column. Apollo's main window will center to the genomic position of 
the column selected. Edit->Deselect all columns deselects all columns. Edit->Remove 
sequence left/right of selected columns will truncate all sequences to the left or right of the 
selected column. 

Font type,size and style can be changed with the Font menu. Jalview is optimized for fixed 
width fonts, so Courier is the recommended font to use for speed. The non-fixed-width fonts 
(Helvetica and Times-Roman) can get a bit slow when displaying many sequences. 

View->Boxes toggles showing the colored boxes. 

View->Wrap alignment toggles wrapping of the alignment rather than showing it all on one 
line. Wrapped alignment is buggy. Sequence labels get blacked out and exceptions get 
thrown. 

View->Black text makes the sequence text black (this is the default). View->Colour text 
makes the sequence text colored. You can only see this if "View->Boxes" is toggled off. 

The Colour menu allows you to choose between three colour schemes. Zappo is the default 
(though because of a bug the checkbox is not checked). The Percent Identity Colour scheme 
colors for match/mismatch. The "Set minimum percent identity for match..." menu item lets 
you set the minimum percent identity that counts as a match. 

Calc menu: Sort by group is the default sorting. Peptides are one group, DNA features are 
another. Many items in this menu don't work yet. 

Jalview lets you choose any two sequences being aligned and look at a pairwise comparison. 
For example, you could pick one of the BLASTX results and one of the frames of the 
translated genomic to select both), and then, under the Calc menu, choose "Pairwise 
alignments". 
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If you select more than two sequences and choose "Pairwise alignments", Jalview will show 
pairwise alignments for each pair. 

Please see the Jalview manual for more information about Jalview, but note that not all of the 
functionality in the standalone version of Jalview described in that manual is available from 
within Apollo. 

Also be aware that Jalview uses a lot of memory, and that if you launch multiple Jalview 
windows, Apollo may run out of memory. 

Known Jalview bugs are listed in the doc/todo file. If you encounter a problem that is not 
listed in that file, please report it via the SourceForge Apollo bug tracker or via the Apollo 
mailing list. 

Viewing graph data

Apollo now has rudimentary graph support. To load tracks to your data, select "File -> Layer 
more results or annotations...". Choose "Graph data" as your data source. Then select the file 
you want to load (you can also use the "Browse..." button to graphically navigate the file 
system. Currently, Apollo only supports Affymetrix's IGB (".sgr") and USCS Genome 
Browser's wiggle (".wig") formats. Wiggle supports all 3 different structures (BED, 
variableStep, fixedStep). It also supports loading of wiggle files with multiple tracks. 
However, the track definition line parsing is still very basic, only supporting the "color" 
parameter. This is useful when loading a wiggle file with multiple tracks, as each track has its 
own color. You can also choose the color for the graph data by clicking on the "Choose color" 
button when loading your graph files.

69

http://apollo.berkeleybop.org/current/userguide.html#mailing
http://apollo.berkeleybop.org/current/userguide.html#mailing
http://sourceforge.net/tracker/?func=add&group_id=27707&atid=462763
http://apollo.berkeleybop.org/todo
http://www.jalview.org/documentation.html


All graphs share the same resizable panel in the main Apollo window. Resizing the panel will 
resize all graphs accordingly. If you mouse over a region on the graph with a score associated 
with it, a popup box will show up showing the genome position and the score associated with 
that position. Also, if you right click on a graph panel, you'll get a popup menu. This menu 
has the following functions:

• Change color
o Displays a color chooser and allows you to change the color of the graph.

• Remove graph
o Remove the graph from the current session.

• Close this menu
o Close the popup menu.

Saving the Apollo screen as a postscript file
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Apollo can output a postscript file of the current display by selecting 'Print to File' from the 
File menu. A dialog box will appear, letting you select the filename and the paper size. 

To be honest, though, you're probably better off using a program that lets you "grab" windows 
to make screenshots. 

Links to useful software analysis web sites  .  

For your convenience, the Links menu provides a brief "hotlist" of links to sequence analysis 
web sites that you may find useful. When you select one of the links, your web browser will 
come up pointing to the selected site. You can then copy and paste a sequence of interest into 
the web form. To select the sequence you want to analyze, you can rubberband a region of 
sequence immediately above or below the central axis, or click on results of interest and then 
select "Sequence..." to see their sequence(s) in a popup window from which you can copy. 

Apollo help

This user manual is available from Apollo by selecting "Apollo userguide..." from the Help 
menu. If you are reading this, you probably already knew that. Just keep in mind that it may 
take a while for your web browser to bring up the user manual. 

Checking for Apollo software updates

One of the menu items in the Help menu directs your web browser to the page where you can 
download Apollo, so you can check whether there's a newer version that you might want to 
download. You can check which version you currently have by using the "About" menu item 
in Apollo's Help menu. (Please note that on Macs, there is an "About Apollo" menu item at 
the top of the screen. This will not tell you the true Apollo version number--it actually tells 
you the version number of the installer that was used to create the Apollo package.) 

Summary of mouse functions

Mouse buttons perform many functions in Apollo. The table below summarizes the functions 
performed by the three mouse buttons, with and without holding down the shift key. 

If you are on a Mac and have a single-button mouse, you can simulate a right mouse click by 
holding down the control or alt key while clicking the mouse, and you can simulate a middle 
mouse click by holding down the apple key while clicking the mouse. If you are trying to 
copy text from Apollo (for example, sequence residues from a Sequence window) to paste 
into another application, use ctrl-c to copy the text and apple-v to paste it (or, if you are trying 
to paste into a Web browser, you can use the 'Paste' command from the browser's Edit menu). 

Please note that if you are running an old version of Mac OS X (10.2.2 or earlier), you may 
find strange mouse-button behavior. With a three-button mouse, you may find that the 
behavior of the right and middle buttons is switched. If you have an old Mac and a five-button 
mouse, both the left button and the middle (wheel) button are treated as the left button, while 
the two buttons on the far left side of the mouse are treated as the middle button. 

On a Windows laptop you may find that the middle mouse button will pop up a little 
scrollbar. To simulate middle mouse you might have to use the Alt key with the left mouse 
button. 

Mouse key Action
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Left Select feature (or deselect if you're not over any features)

Shift-Left Add feature to current selection (or remove feature if it's already selected) 

Left drag If you drag a feature into the annotation tier, it will be added as a new 
transcript (if editing is enabled)

Shift-Left drag If you shift-drag a feature onto an annotation, it will be added as a new exon 
(if editing is enabled)

Middle click Center display on clicked location

Middle drag Rubberband multiple features

Shift-Middle 
drag

Rubberband multiple features, adding to current selection (or remove if they 
are already selected)

Right Popup menu

Shift-Right 
drag Tier drag--move currently selected tier

Using Apollo to edit annotations

The previous sections have dealt with using Apollo as a browser. If you are annotating a 
genome, you may be interested in using Apollo as a curation tool. This section explains how 
to use Apollo's annotation curation and editing capabilities. 

If you want to edit annotations, Chado XML or GAME XML format works the best. Ensembl 
GFF format (which is also used by the Ensembl server) is not a rich enough data format to use 
for curating annotations. If you turn on editing in gff.style, you will find that it doesn't work 
right. 

Saving data

After you create or edit annotations, you will probably want to save your work. To save the 
current dataset, select "Save as..." from the File menu. If you know you want to save your 
data in the same file you read it from, you can use the "ctrl-s" shortcut to bypass the 'Save as' 
dialog. ("Ctrl-a" is the shortcut for "Save as"--see the next paragraph about 
AskConfirmOverwrite.) 

If the file you choose for saving your data already exists, Apollo will pop up a dialog box 
asking you if you really want to overwrite the file. If you prefer not to be asked this question, 
you can put

AskConfirmOverwrite "false"

in your apollo.cfg file. 

Some data adapters (such as the GAME XML adapter and the Chado XML adapter) offer you 
the option to save only the curated annotations, only the computational results, or both. (You 
can then load and layer the annotations and results separately.) 

A note about GAME XML formats: in November 2005, we enabled the GAME Adapter to 
write (and read) one-level annotations (previously, these were inflated into phony three-level 

72

http://apollo.berkeleybop.org/current/userguide.html#apollo.cfg
http://www.fruitfly.org/annot/apollo/game.rng.txt


annotations) in a new version of GAME XML, v1.1 (the previous version was 1.0). If you 
save your data in GAME 1.1, older GAME XML readers may not be able to read it. 
Currently, the choice of GAME format is controlled by the DO-ONE-LEVEL-ANNOTS 
parameter in apollo.cfg ("false" means save GAME 1.0; true means save GAME 1.1). 

Apollo supports several output formats, including Ensembl GFF format and GAME XML. 
The GFF format is simpler (though less rich) and more compact. It is a good format for 
representing simple computational results, but is not the best choice for saving annotations. 

Note that although theoretically Apollo can be used to convert between data formats (e.g. 
GFF <-> GAME), in practice this doesn't work very well. We are working on improving this 
interconversion. 

We recently added the ability to save annotations in GenBank format. There are two options: 
tabular format (which is useful mostly for making submissions directly to GenBank) or the 
more familiar "human-readable" format (see Reading GenBank/EMBL). The GenBank writer 
is still being debugged--please report any problems to us. 

Some of the data adapters (GAME XML, Chado XML) now save a separate transaction file 
when you save your data. Transaction files describe the edits that were made in this session. 
At the moment, these are only of interest to developers. Don't worry if you see error messages 
relating to the transaction file. Your actual edits should all be saved in the data file you 
specified. 

Autosaving

In order to protect against possibly losing changes that you've made to the annotations, Apollo 
automatically saves your data in a backup file in your .apollo directory every 20 minutes (that 
interval can be changed in apollo.cfg). Be aware that if you leave Apollo running for a long 
time, the autosave file (apollo.backup) will get bigger and bigger. 

You can also save to a backup file at any time by selecting "Save as" from the File menu and 
choosing "Apollo backupfile" from the pulldown list of output formats. When you reload the 
backup file, you should see all your data. However, backup files are not guaranteed to work 
with different Apollo versions--you need to load them with the same version of Apollo that 
generated them. 

Another thing to note about the backup format is that it is independent of the data adapter 
used--it can store data loaded by any Apollo data adapter. However, in order to reload your 
data from the backup file, Apollo needs to know which style file to use to display the data 
appropriately. By default, it uses fly.style; if you were not reading fly data, you may need to 
modify the style parameter in the DataAdapterInstall line for SerialDiskAdapter in your 
apollo.cfg file. 

General notes on editing

Throughout the instructions on editing, a single left mouse click will select an exon, a double 
left mouse click or clicking on an intron selects a transcript. Use the shift key to select 
multiple features. A right mouse click brings up the option menu. In some cases one can 
rubberband desired features by dragging with the middle mouse button held down. 

A center click on a feature will bring that feature to the center of the view. 

For many operations selecting an exon or the whole transcript achieves the same result. 

73

http://apollo.berkeleybop.org/current/userguide.html#apollo.cfg
http://apollo.berkeleybop.org/current/userguide.html#ReadingGenbank
http://www.ncbi.nlm.nih.gov/Sequin/table.html
http://www.fruitfly.org/annot/apollo/game.rng.txt
http://www.sanger.ac.uk/Software/formats/GFF/


If you have selected more than one transcript and you click the right mouse to bring up the 
popup menu, in most cases the command will apply to the transcript closest to where you 
clicked. 

Note that the edges of the Apollo window may extend beyond the actual sequence region. If 
you try to edit annotations in these out-of-range regions, you probably will get a popup 
message warning you that edits out of the current region may not get saved in the database. 
However, it is possible to do edits out of range that don't trigger a warning. 

Transcript coloring

If UserTranscriptColoring is set to "true" in apollo.cfg, then each gene transcript is colored 
according to its creator. By default, UserTranscriptColoring is off and all annotations are 
shown in the annotation color defined in the tiers file. The user colors (and which project the 
users belong to) are defined in the style file (e.g. conf/fly.style); you can add your own colors 
for the users who are annotating genes at your site. The format of the user color lines is 
UserInfo "user=nomi:project=FlyBase:color=255,255,92"

Please note that currently user coloring applies only to protein-coding genes; other types of 
annotations are colored according to the color defined in the tiers file. 

Creating an annotation

To create a new annotation or transcript, you can simply select results on which to base the 
annotation and drag them into the light blue annotation zone. As you drag the selected 
result(s), you will see a ghost image. When you drop them, an annotation will be created. If 
your selected result is of a type that would normally create a protein-coding gene (as specified 
in the tiers file), and if there is already a gene transcript whose ORF overlaps the ORF 
covered by the new transcript, your new gene model will be added to the existing gene as a 
new transcript. (If instead you want to add a new annotation in a region where there is already 
an existing annotation, then instead of dragging you should use the right mouse popup menu 
option "Create new annotation".) 

In the four screenshots below, the user has created a new gene transcript annotation based on 
a piece of evidence by choosing a bright green cDNA and dragged it down into the annotation 
area. You can see the "ghost" of the dragged cDNA moving down until it enters the blue 
annotation zone and then becomes a new transcript of the Hph gene. 
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If your new transcript overlaps two or more existing genes, and the CDS of the new transcript 
would overlap the existing genes in the same frame, you will be asked whether you want to 
create a new overlapping gene, merge the two existing genes that overlap with each other, or 
add as a new transcript to one of the existing genes. 

You can also use the right mouse popup menu options to create a new transcript or a new 
annotation. "Add as gene transcript" will add a transcript to an existing gene (if there is one 
that overlaps) or create a new annotation--it is the same as dragging a result into the 
annotation panel. "Add as gene transcript" assigns the transcript or annotation type based on 
the type of the result selected. 

Another menu option, "Add as new transcript to selected gene," allows you to select an 
annotation and a result and add a new transcript, based on the result, to the selected 
annotation. In order to activate that menu option, you must select an annotation and then shift-
click to select the desired result. Keep your mouse in the result (not annotation) zone and click 
the right mouse button to get the popup menu. 

The menu option "Create new annotation" will always create a new annotation (rather than 
adding a new transcript to an existing annotation), even if there is already an existing 
annotation in the same region. When you select this option, you will get a pull-right menu of 
annotation types from which to choose. If you have selected a result, its span(s) will be used 
as the basis of the new annotation. 

Creating a new annotation with no evidence

You can create a new single-span annotation with no supporting evidence. Just right-click on 
an empty area in the blue annotation zone, and choose the "Create new annotation" menu 
item. You will get a pull-right list of annotation types from which to choose. The spot you 
clicked will be the 5' endpoint of the new annotation, and you will be asked to specify its 
length. 

Modifying gene models

When you create a new annotation from a result, the type of the new annotation will be 
determined by the result type (as specified in the tiers file). You can use the Annotation Info 
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editor to change the annotation type, as well as other information about the annotation, such 
as its name and synonyms. 

Deleting exons

To delete exons (or whole transcripts), select the unwanted feature(s) (you can use shift-click 
to select multiple features), click the right mouse to bring up the menu, and select "Delete 
feature". (Note that when you click the right mouse button, you must have your cursor over 
the same strand as the selected feature.) 

Adding exons to an existing transcript

To add a result exon to an existing transcript, hold the shift key while dragging the result exon 
(or exons) onto the desired transcript. 

Merge exons - will remove the intron between two exons.

1. select exon
2. depress the shift key
3. select another exon in the same transcript
4. right click to bring up popup menu
5. select 'merge exons'
6. The two exons will merge into one exon. All introns between the two exons will disappear 
and exons that were between the two exons will be merged. 

Split exon - will create a one base intron in the middle of an exon.

1. select an exon
2. put cursor on exon where you want the intron to be and right click
3. get popup menu
4. select 'split exon'
5. you may have to zoom in to see the intron (if you select on the exon again, only half should 
appear selected because of small intron). You can then drag the ends of the adjacent exons in 
the EDE to construct an intron of appropriate size. 

Move exons to transcript - will move exons from one transcript to another.

1. select all of transcript A with a double left click (left mouse) (this option will only enable if 
the whole transcript is selected)
2. depress shift key
3. select exon(s) from transcript B 
4. right click in annotation zone to get popup menu
5. select 'Move exons to transcript' 
6. The exons from B are removed from B and added to A. If they overlap with A's exons you 
have the option to merge the genes.
Note: If all of A's and B's exons are selected it is equivalent to "merge transcripts". 

Merge transcripts - merges all exons from two transcripts.

1. select exon or all of transcript A
2. depress shift key
3. select exon or all of transcript B 
4. right click in annotation zone to get popup menu
5. select 'Merge transcripts' 
6. The two transcripts will be merged into one. Overlapping exons will be merged. Note that 
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you will have the option to merge the genes if this causes an overlap of the CDS in the same 
frame. 

Split transcript - will remove the intron connecting two exons and create two separate 
transcripts.

1. select exon at one end of split location
2. depress shift key
3. select exon at other end of intron where you want the split to occur.
4. right click and get popup menu
5. select 'split transcript'
6. intron will be removed and one transcript will be split into two separate transcripts.
7. note that one of the newly split transcripts may be in a different vertical position, so you 
won't see it unless you scroll. 

Set as 5' end

1. select exon in annotation zone that you wish to modify
2. depress shift key
3. select exon in results panel whose boundaries you wish to adopt
4. right click in annotation or results panel to get popup menu
5. select "set as 5' end"
6. exon boundaries will be extended 

Set as 3' end 

1. select exon in annotation zone that you wish to modify
2. depress shift key
3. select exon in results panel whose boundaries you wish to adopt
4. right click in annotation or results panel to get popup menu
5. select "set as 3' end"
6. exon boundaries will be extended 

Set both ends

1. select exon in annotation zone that you wish to extend
2. depress shift key
3. select exon in results panel whose boundaries you wish to adopt
4. right click in annotation or results panel to get popup menu
5. select 'set both ends'
6. exon boundaries will be extended

Duplicate transcript

1. select transcript
2. right click to bring up option menu
3. select 'Duplicate transcript'
4. transcript will be duplicated and assigned a new suffix. Note that you may have to scroll to 
see the new transcript. 

Calculating longest open reading frame

If you add or delete exons from a transcript, the open reading frame should be automatically 
recalculated. You can also explicitly request it to be recalculated by using the "Calculate 
longest ORF" option from the right mouse popup menu. 
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Changing the strand of a result

If a result feature has been assigned the wrong strand you can move it to the other strand. 
Select the result feature, right click to get toe popup menu, and select "Move to other strand". 
The result will then be moved to the opposite strand. (If you've selected more than one result, 
all of them will be moved.) 

Tagging a result with a comment

Apollo allows you to tag results (of the types defined in the style file) by selecting from a list 
of comments that are also specified in the style. These ResultTag lines look like this: 
ResultTag "DGC cDNA, Community GB:comment: incomplete CDS"
What this means is that when you select a whole result (double-click) of type "DGC cDNA" 
or "Community GB", there will be a right-menu option that allows you to add a tag 
"comment: incomplete CDS". These tags are saved in the XML as s of type tag. 

When a result has been tagged with a comment, it is crosshatched in hot pink: 

Editing annotation text

To bring up the annotation text editor for a transcript, choose the "Annotation info editor" 
option in the right-mouse popup menu. The annotation information window will appear for 
the selected gene/transcript, which allows the curator to 1) select a type of entity for the 
annotation, e.g. gene (protein-coding gene, the default), tRNA, transposable_element, etc.; 2) 
change the symbol, ID, or synonyms of the annotations or transcripts; or 3) add comments to 
annotations or individual transcripts. 
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To add a new comment to the annotation, click the top "Edit [symbol] comments" button. To 
add a new comment to one of the transcripts, select the transcript in the annotation tree at the 
left of the editor panel, then click the bottom "Edit [transcript symbol] comments" button. 
Either action will open a Comments popup window, allowing you to edit existing comments, 
by selecting an author/date pair in the upper window, or add a new comment, by clicking the 
"Add" button at the bottom. 

When you add a new comment, you can either type in free text or use a canned comment from 
the pulldown menu. When you do that, the comment should appear in the Comments panel in 
the main Annotation info editor display. (Note that you can't edit the comment in the 
Comments panel in the main annotation info window, only in the Comments popup window.) 

To edit an existing comment, select it from the list by author name and date. The comment 
text will appear in the righthand panel; edit it as desired in the window, or click the "Delete" 
button to delete it. When you are finished editing comments, click the "Close" button on the 
Comments popup window. 

The annotation information editor also lets you add or delete synonyms for the annotation or 
transcript; indicate whether the annotation or transcript is problematic and/or dicistronic; or 
choose one of the possibilities for Evaluation of Peptide. 

To add new synonyms to an annotation or a transcript, click the "add" button in the 
appropriate Synonyms area. A popup window will prompt you to enter the new synonym 
name. You can delete existing synonyms by selecting one from the list of synonyms and 
clicking the "delete" button to the left of the synonym list. 

All changes made in the Annotation Info Editor are saved immediately, without having to hit 
a button. If you click "Undo" you will discard the most recent change you made in that 
Annotation Info Editor window. Clicking "Undo" again and again will discard each change 
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you made going backwards in time. This goes for changes to comments as well as any other 
annotation info editor change. When you hit "Close", you close the window and can no longer 
Undo changes. 

Set owner

To claim ownership of a transcript, select the transcript (or an exon belonging to the 
transcript) in the main Apollo window, right click to bring up the popup menu, and select "Set 
owner to [yourname]". If you bring up the popup menu again on the same transcript, you will 
now see the option to disown the transcript. Note that if you make changes to a transcript's 
structure, you will automatically be set as the owner of that transcript (unless you then select 
"Disown" from the menu). 

Mark a transcript finished or unfinished

After selecting a transcript (or an exon belonging to it), right click to bring up the popup 
menu. If the transcript is marked finished, you will see a menu option "Set [transcriptname] 
unfinished". If it is already finished, you will see "Set [transcriptname] completed". You can 
also mark a transcript finished/unfinished in the Annotation Info Editor. 

Change annotation or transcript symbol

You can edit the annotation or transcript symbol in the annotation info window. The transcript 
symbol is expected to be the annotation symbol plus a legal suffix (-RA, -RB, etc.). 

Change annotation ID

Privileged users are now allowed to change annotation IDs from the annotation info editor. 
Changing annotation IDs within Apollo should be done with caution. The ultimate 
arbiter of annotation IDs is the database management system that tracks all the 
annotations. The IDs you assign within Apollo are only suggestions to the database 
software. 

The format of the ID must be appropriate for the type of annotation--for example, gene IDs 
must follow the format CG\d+, and P insertion IDs must follow the format FBti\d{7}. These 
ID formats are defined in the tiers file. 

If the format of the annotation symbol matches the format of the annotation ID (e.g. symbol is 
CG1234, id is CG1234) they are expected to match (i.e. it won't let you assign 
symbol=CG1234, id=CG9999). 

Indicating translation exceptions

Certain exceptions in the translation of transcripts can be indicated in Apollo using the 
annotation info editor. For example, if a transcript has a readthrough stop codon, you can 
check the box next to "Readthrough stop codon", click "Commit", and the ORF will be 
extended to the next stop codon. The specific residue for the readthrough stop codon cannot 
be defined from inside Apollo, but if it is indicated in the input (in GAME or ChadoXML 
format), it will be carried through. The original stop codon shows up in pink in the main 
display and in the Exon Detail Editor. You will see the replacement residue for the stop codon 
if you zoom in on the transcript in the main window, or use the Sequence window to look at 
the peptide sequence for the entire transcript. (If you view the peptide sequence of an 
individual exon in the Sequence window, you will see a * for the readthrough stop codon 
rather than the replacement residue.) 
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Other translational exceptions, like frame shifts or genomic sequencing errors, are made using 
the Exon Detail Editor (see below), but the exceptions are reported in the annotation info 
editor. 

If a +1 or -1 translational frame shift for the transcript has been indicated using the Exon 
detail editor, the coordinate of the frame shift in the sequence being viewed in Apollo appears 
next to "+1 translational frame shift" or "-1 translational frame shift". 

If a transcript is missing a start codon, it will appear in the main display with a green 
arrowhead, and if it is missing a stop codon, it will appear with a red arrowhead. 

This will also be indicated in the annotation info editor next to "Missing start codon" or 
"Missing stop codon". 

If a gene uses an unconventional start codon, it will appear in purple, and the codon will 
appear in the annotation info editor next to "Unconventional start codon". The codon will be 
translated as a Methionine in the protein. 

Accepting non-consensus splice sites

Exceptions to consensus GT-AG splice sites are indicated in the Apollo display (see Non-
consensus splice sites). Curators have the option of accepting non-consensus splice sites, to 
indicate that they are not due to an annotation error, using the annotation info editor. For 
example, in the figure below, the curator can check the box next to "Approve non-consensus 
acceptor in exon 4 and donor in exon 3". 
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Exon Detail Editor

The Exon Detail Editor can be invoked from the right-mouse popup menu when you select an 
annotation that has sequence associated with it. A separate window will appear that shows the 
reference nucleotide sequence centered around the selected feature. A separate line of 
sequence is displayed for each transcript that appears in the annotation zone in the region 
being viewed. The three-frame translation of the sequence is also displayed. The exons for 
each transcript are denoted on the sequence in blue with successive exons being shown in 
alternating light and dark blue shades (these colors are configurable--see configuring the Exon 
Detail Editor). The boundaries of these exons can be moved by left-clicking on the terminal 
nucleotide and dragging the mouse to either extend or shrink the exon. 

The graphic at the bottom of the exon editor window shows the exon structure of the selected 
transcript and the translation start and stop. The numbers on the exons indicate the translation 
reading frame for that exon: 1 refers to the top reading frame in the viewer, 2 is middle, 3 is 
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bottom. The black outline indicates the region of sequence that is current visible in the exon 
detail view. You can click anywhere on this exon structure graphic to move the currently 
visible region (but note that if you click on a region that extends beyond the genomic region, 
the display may look weird). 

If there are multiple annotations, multiple lines of sequence will show up with successive 
exons highlighted in alternating medium and dark blue shades. To determine which line of 
sequence corresponds to which annotation, click on the nucleotide sequence and look at the 
transcript name displayed in the transcript pulldown menu in the lower left corner. Translation 
length is also provided. The number of lines of sequence displayed corresponds to the 
maximum number of sequences that are needed to show for the whole strand. For example, if 
there is a gene with six transcripts on the current strand and you are looking at a gene with 
one transcript, you will see one line with the transcript and five sequence lines with no 
features in the region you're looking at. 

Clicking on the graphic of the transcript will center the sequence around the region of the 
transcript that you clicked on. This is the easiest way to navigate in the exon detail editor 
window. Scrolling with the side bar shifts the sequence by one complete view (no overlap 
with previous view). Clicking on the top and bottom arrows moves one line of sequence at a 
time (including all aligning sequences). You can also use the buttons near the bottom right of 
the window to move to the previous (5') or next (3') annotation. 

The transcript pulldown menu lists all the transcripts of the current annotation (or, if this is a 
one-level annotation without transcripts, the current annotation name). Selecting a transcript 
in the pulldown will switch the focus of the exon editor window to that transcript. 

You can always tell in the main viewer what region of sequence you are looking at in the 
exon detail editor because the region is bracketed by thin vertical lines in the main viewer. 
The color of the lines matches the color of the colored thick horizontal bar at the top of the 
exon editor window. (Multiple exon editor windows can be opened simultaneously. Each one 
is marked by a horizontal line of a different color.) You can navigate by clicking on the 
vertical lines(or between them if you are zoomed in) in the main viewer and dragging them 
horizontally. You must have the mouse pointer in the white sequence coordinate zone to be 
able to drag the vertical bars. If the mouse is in the results panel or the annotation zone, it will 
not work. 

The "Clear search hits" button allows you to clear the results of a sequence search--see "Find 
sequence" below. 

The "Show introns in translation viewer" checkbox denotes whether to show introns in the 
transcript graphic. Turning off this option will show a transcript graphic devoid of introns. 

The "Follow external selection" checkbox is used to follow selections from other parts of 
apollo. If it is checked, the exon detail editor will move to show the transcript you clicked on 
in the main window, as long as the transcript is on the same strand that the exon detail editor 
is currently showing. 

To access the menu in the exon detail editor, right click on a nucleotide in the genomic 
sequence. A menu will appear and different options will be enabled depending on where you 
clicked in the sequence window. For example, different options are available if you click on 
exon sequences vs. intron sequences. 

Configuration options for the Exon Detail Editor
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There are several display options for the Exon Detail Editor that can be set in the appropriate 
style file. Please see the table of style parameters for more details. These configurable 
parameters include ExonDetailEditorSequenceFont; 
ExonDetailEditorBackgroundColor1 and ExonDetailEditorBackgroundColor2 (for 
setting the colors of the background stripes); and ExonDetailEditorFeatureColor1 and 
ExonDetailEditorFeatureColor2 (for setting the two alternating colors of the exons). 

Using the Exon Detail Editor

The following options are possible in the exon detail editor. 

Sequence...

1. Left click to select a transcript.
2. Right click on exon detail editor window.
3. Select 'Sequence...'
4. A Sequence window will come up with the sequence for the selected feature, as with the 
"Sequence..." option from the annotation and result menus. 

Find sequence

1. Right click in the exon detail editor window
2. Left click on 'Find sequence'
3. A window will pop up.
4. Enter the sequence you're looking for in the 'Sequence' text area. You can use regular 
expressions in your search string (see the section on using regular expressions).
5. Select 'is amino acid sequence' or 'is genomic sequence' as appropriate.
6. Left click on 'Search'
7. If the sequence is found in one or more locations, the coordinates will appear in separate 
boxes. If you click on one these coordinates, the exon editor will scroll to that site. The 
sequence that you searched for will be in the top line of the window and will be outlined in 
yellow.
8. To turn off the yellow outlines, click "Clear search hits".

Make intron - makes one base break

1. Right click on a base in an exon.
2. Left click on 'Split'.
3. A one base break (intron) is made in the exon at the base that you clicked on. You can click 
and drag on the exons to trim the 3' edge of the upstream exon to an appropriate splice site 
donor, and trim the 5' edge of the downstream exon to an appropriate splice site acceptor. 

Create exon - creates exon with conserved boundaries

1. Right click on a base in an intron. (You cannot create an exon outside of the transcript in 
the exon detail editor. Use the main viewer.)
2. Left click on 'Create exon'.
3. An one base exon is created within the intron. You can click and drag on the exon to extend 
the 5' and 3' edge to an appropriate splice site acceptor and donor, respectively. 

Delete exon

1. Right click on a base in an exon.
2. Left click on 'Delete exon'.
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3. The exon that you clicked on will be deleted and the remaining exons will be joined to 
reform the transcript. 

Merge with 5' exon - Deletes intron and merges exon with adjacent 5' exon.

1. Right click on a base in an exon.
2. Left click on 'Merge with 5' exon'.
3. The exon that you clicked on will be merged with the next exon in the 5' direction by 
deletion of the intervening intron. If there is no exon in the 5' direction, this option will not be 
highlighted. 

Merge with 3' exon

1. Right click on a base in an exon.
2. Left click on 'Merge with 3' exon'.
3. The exon that you clicked on will be merged with the next exon in the 3' direction by 
deletion of the intervening intron. If there is no exon in the 3' direction, this option will not be 
highlighted. 

Set as 5' end

1. Right click on a base in an exon.
2. Left click on "Set as 5' end".
3. The base that you clicked on will now be the 5' end of the exon. Other aspects of transcript 
structure will remain unchanged. The exon edge will be set at the base you specify regardless 
of the presence or absence of an appropriate consensus splice site adjacent to it. 

Set as 3' end

1. Right click on a base in an exon.
2. Left click on "Set as 3' end".
3. The base that you clicked on will now be the 3' end of the exon. Other aspects of transcript 
structure will remain unchanged. The exon edge will be set at the base you specify regardless 
of the presence or absence of an appropriate consensus splice site adjacent to it. 

Set start of translation

1. Right click on a base in an exon.
2. Left click on 'Set start of translation'.
3. The base that you clicked on will now be the first base of the translation initiation codon. 
You can set the translation start at any codon. If the start is an ATG, the site is marked in 
green. If the start is not an ATG, the site is marked in purple, and the Unconventional start 
codon will be listed in the Annotation info editor. Unconventional start codons are 
automatically translated as Methionines. 

Notes about auto-setting of translation start and end

If any of the following situations holds, Apollo auto-sets the translation start AND the 
translation end: 

• The user specifically requests it with the main display third mouse popup "Calculate 
longest ORF" option.

• It is a new gene
• It is a entirely new transcript for an existing gene (but not a duplication; they inherit 

the start from the original transcript).
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• It is the 3' transcript arising from a split.
• The exon containing the translation start is deleted. 

Apollo auto-sets the translation end (but not the start) if: 

• A new translation start is set from either the drag of a start codon onto the transcript or 
from the menu in the EDE.

• It is the 5' transcript arising from a split.
• There is a transcript merge.
• The exon edges (aka splice junctions) are modified.
• Any new exons are added.
• Any exons are deleted.

When Apollo decides to auto-set the translation start, this is what it does: 

1. Starting from the most 5' end of the transcript it scans for ATGs in all 3 frames of the 
mRNA transcript (introns removed).

2. For the ATG encountered in each frame it attempts a translation using that as the 
starting point.

3. The ATG that provides the longest predicted peptide is used. 

Setting translational frame shifts

A +1 translational frame shift can be set in the Exon Detail Editor by selecting the nucleotide 
to be skipped, using the third mouse button popup, and selecting "Set +1 translational frame 
shift here". The base will be highlighted in orange in the Exon Detail Editor, and Apollo will 
skip over this base and move forward one frame, to continue the translation of the sequence in 
the +1 frame over. In the example below, TCCTGAT is translated as Ser-Asp, and the 
translation frame shift goes from frame 2 to frame 3. The coordinate of the position is 
indicated in the annotation info editor. Only one frame shift is allowed per transcript. 

A -1 translational frame shift can be set in the Exon Detail Editor by selecting the nucleotide 
to be skipped, using the third mouse button popup, and selecting "Set -1 translational frame 
shift here". The base will be highlighted in orange, and the translation will move backwards 
one reading frame, by slipping back and re-reading the base pair just upstream of the base pair 
at which the frame shift was selected. 

To undo the frame shift, select the base, and with the third mouse popup, select "Remove 
[+1/-1] translation frame shift here". 
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Indicating genomic sequencing errors

A limited number of one base pair edits can be performed on the genomic sequence, to allow 
the correct translation of a gene model. To delete a single base pair selected in the Exon 
Detail Editor, use the third mouse popup menu, select "Adjust for sequencing error here", and 
select "Deletion". The base pair will remain in the display, highlighted in orange, but any 
features overlapping this base pair (annotated transcripts, translated transcripts) will not 
include it. 

The change will be indicated in the Annotation info editor in the lower right "Genomic 
sequencing errors" panel. 

To make an insertion in the genomic sequence, select a base pair, use the third mouse popup 
menu, select "Adjust for sequencing error here", and select "Insertion..." A new popup will 
allow you to choose which nucleotide to add at that position. 

The new base pair will not appear in the display, but the position just downstream of the 
inserted base pair will be highlighted in orange, and any features overlapping this base pair 
(annotated transcripts, translated transcripts) will include it. A warning popup window will 
ask you to make sure you want to alter the translation of any features in this region. 

To make a one base pair substitution, select the nucleotide to be changed in the Exon Detail 
Editor, use the third mouse popup menu, and select "Adjust for sequencing error here", then 
"Substitution...". A popup will allow you to choose which nucleotide to substitute at that 
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position. The new base will not appear in the display, but the position will be highlighted in 
orange, and any features overlapping this base pair (annotated transcripts, translated 
transcripts) will include it. You will also see the change noted in the "Genomic sequencing 
errors" section if you bring up the annotation info editor for that annotation. 

To remove a change to the genomic sequence, select the highlighted base in the Exon Detail 
Editor, use the third mouse popup menu, and select "Remove 
[deletion/insertion/substitution]". 

Configuring Apollo

apollo.cfg

The main configuration file that Apollo reads when it starts up is called apollo.cfg. The 
default location for apollo.cfg is in the conf directory inside Apollo's home directory. Apollo 
will always read that apollo.cfg first. If you create a .apollo directory in your home directory 
and place an apollo.cfg there, Apollo will read that second, thus allowing your personal 
changes to the default configuration to take precedence. (You can also put personal 
modifications to the style and tiers file in your .apollo directory. This is useful on multi-user 
systems where many people are sharing the same Apollo installation.) 

If you edit any of the configuration files, be careful not to introduce line breaks in any of the 
lines. (If you are using emacs, you may need do "M-x auto-fill-mode" to turn off auto-fill 
mode, which introduces line breaks into long lines.) 

Note that if you make changes to your apollo.cfg file, you will need to shut down Apollo and 
restart it to see the changes. 

Style files

There is a configuration "style" file and a tiers file for each data source (called a Data 
Adapter) that Apollo knows about. These are in the conf directory as well (though, as above, 
you can also have versions in your ~/.apollo directory). The style file for the Drosophila 
annotations, which are in GAME XML format, is called fly.style (which imports the generic 
GAME XML style file, game.style, and then adds or overrides many of the parameters); the 
style file for Ensembl is ensembl.style. The style file specifies the name of the tiers file, e.g. 
fly.tiers for the Drosophila annotations and ensj.tiers for the Ensembl/Otter adapter. This may 
all sound complicated, but most users shouldn't need to do anything to these files. 

The first column of each line in a style file contains property names that are recognized by 
Apollo. The second column contains their values. // denotes the beginning of a comment, so 
any text after // up to the end of the line is ignored. Relative paths (those that start without a /) 
are relative to the directory where Apollo is installed (APOLLO_ROOT), except for paths 
that start with "~/". 

If you want to make any changes to apollo.cfg or a style file, you can put just the lines that 
you've changed in your .apollo directory (or you can copy the whole file, including the lines 
you've changed and the lines you haven't--that's ok, too). The tiers file is a little different, 
because the order of the lines is important, so if you want to change the tiers file, you will 
need a complete tiers file in your .apollo directory. 
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If you edit any of the configuration files, be sure not to add any additional newlines in the 
middle of lines (some editors will insert newlines if a line is too long); this will break the 
parser and Apollo will not be happy. 

It is now possible to import other style files in a style file: 

ImportStyle "other.style"
This causes everything in other.style to be included. Anything you want to change you can 
just add to the new style and it will override the other style. This can help reduce redundancy 
between style files. (Be sure that you don't try to import a style file into itself!) 

Here are the contents of the default apollo.cfg: 

//JavaPath                  "/usr/lib/java"
Memory                    "800M"
//AdapterHistoryFile      "apollo.history"
//AutosaveFile            "apollo.backup"
AutosaveInterval          "20"
// Current species-specific styles for GAMEAdapter are rice.style and 
fly.style
// both of which import game.style, the generic GAME style file.
// The default GAME style is fly.style, but if rice data is read, 
Apollo
// will automatically switch to using rice.style.
DataAdapterInstall   "apollo.dataadapter.gamexml.GAMEAdapter" 
"fly.style"
DataAdapterInstall 
"apollo.dataadapter.chadoxml.ChadoXmlAdapter" "chado.style"
DataAdapterInstall   "apollo.dataadapter.ensj.EnsJAdapter" 
"ensj.style"
PFetchServer              "vegadb.sanger.ac.uk"
DataAdapterInstall   "apollo.dataadapter.GFFAdapter" "gff.style"
DataAdapterInstall  
"apollo.dataadapter.analysis.AnalysisAdapter" "fly.style"
DataAdapterInstall   "apollo.dataadapter.genbank.GenbankAdapter" 
"genbank.style"
PublicSeqDbURL 
"GenBank==www.ncbi.nlm.nih.gov/entrez/viewer.fcgi?
db=nucleotide&val=*"
PublicSeqDbURL            "EMBL==http://www.ebi.ac.uk/cgi-
bin/dbfetch?db=EMBL&id=*"
// The style for Chado is irrelevant as style is dealt with in chado-
adapter.xml config file
DataAdapterInstall        "apollo.dataadapter.chado.ChadoAdapter" 
"rice.style"
DataAdapterInstall   "apollo.dataadapter.synteny.SyntenyAdapter" 
"synteny-game.style"
DataAdapterInstall   "apollo.dataadapter.SerialDiskAdapter" 
"fly.style"

//BrowserProgram          "/usr/local/bin/mozilla"
AskConfirmOverwrite       "true"
SiteShowLimit             "15"
FastDrawLimit             "0.5"
TextAvoidLimit            "1500"

FrameOrientation          "horizontal"
MainWindowWidth           "1000"

OutputTransactionXML      "false"
OutputChadoTransaction    "false"

Karyotypes                "all.kary"
CommandLineXmlFileFormat  "game"
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// Allows for a different style to be loaded for different species
// load from the same adapter. (currently only GAME adapter uses 
this)
SpeciesToStyle "Oryza sativa -> rice.style"
SpeciesToStyle "Drosophila melanogaster -> fly.style"

Other options are set (or overridden) in the style files. Here are the options in game.style and 
fly.style (the style file for displaying Drosophila annotations). fly.style imports game.style; in 
the list below we have combined parameters from both style files to make a more convenient 
reference. 

ShowAnnotations           "true"
ShowResults               "true"
EnableEditing             "true"
EnableNavigationManager   "true"
AnnotationBackgroundColor "176,224,230"  // aqua
FeatureBackgroundColor    "black"
EdgematchColor            "white"
EdgematchWidth            "2"
FeatureLabelColor         "white"
AnnotationLabelColor      "black"
CoordBackgroundColor      "white"
CoordForegroundColor      "black"
UserTranscriptColouring   "false"
SelectionColor            "255,0,102"  // pinkish-red
EvidencePanelHeight       "175"
DashSets                  "true"
SequenceGapColor          "231,255,51"
Draw3D                    "false"
DrawOutline               "false"

DefaultFeatureLabelFont "Dialog,0,10"
DefaultFont "Dialog,0,12"
ExonDetailEditorSequenceFont "Dialog,0,12"
ExonDetailEditorBackgroundColor1 "gray"
ExonDetailEditorBackgroundColor2 "black"
ExonDetailEditorFeatureColor1 "0,102,255"  // medium blue
ExonDetailEditorFeatureColor2 "0,0,180" // dark blue

Types           "fly.tiers"
DisplayPreferences        "apollo.config.FlyDisplayPrefs"
Organism                  "Drosophila melanogaster"
Chromosomes               "2L,2R,3L,3R,4,X,2h,3h,4h,Xh,Yh,U"
ExternalRefURL            "http://flybase.net/.bin/fbidq.html?"

GeneURL "http://flybase.net/cgi-bin/apollo.cgi?gene="
BandURL "http://flybase.net/cgi-bin/apollo.cgi?band="
RangeURL "http://flybase.net/cgi-bin/apollo.cgi?range="

AnnotationComment "DGC clone appears problematic: [DGC: ] incomplete 
CDS"
[etc.]

TranscriptComment "GC splice donor site postulated"
[etc.]

UserInfo "user=suzi:project=FlyBase:color=25,25,112:full-name=Suzanna 
Lewis"
UserInfo "user=sima:project=FlyBase:color=255,255,0:full-name=Sima 
Misra"
[etc]

PeptideStatus "2:Arial,0,9:true:curator examined, accepted"
[etc]

ResultTag "EST Same Strain, EST Different Strain, Fly EST All, DGC 
cDNA, Community GB:comment: incomplete CDS"
[etc]
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The table below explains the parameters that you can use in apollo.cfg: 
Parameter Explanation

JavaPath

The path to the place where the bin/java executable lives (used 
by the bin/apollo script). For example, on Mac OSX, java is 
/usr/bin/java, thus JavaPath is /usr (because bin/java is in /usr).
If you've used the installer to install Apollo, it should have 
come bundled with the appropriate JVM, so you shouldn't need 
to change this (in fact, changing it will have no effect). 

Memory

How much memory the JVM can use (used by the bin/apollo 
script). NOTE: if you are using the installed version of Apollo, 
this parameter will be ignored--the memory allocation is 
specified inside the installer. However, this parameter is used 
when monitoring to make sure you're not about to run out of 
memory. 

AdapterHistoryFile

File containing a history of recently used commands and 
settings. By default, if AdapterHistoryFile is not specified, 
Apollo will check to see if you have a ~/.apollo directory. If so, 
it will save the history file there. If not, it will save it in 
APOLLO_ROOT/data. You can override these locations by 
setting AdapterHistoryFile to a different path. 

AutosaveFile

The file to autosave to (when you have editing enabled). If 
AutosaveFile is not specified, Apollo will check to see if you 
have a ~/.apollo directory. If so, it will save the autosave file 
there. If not, it will save it in APOLLO_ROOT/data. You can 
override these locations by setting AutosaveFile to a different 
path. 

AutosaveInterval

The number of minutes (e.g. "20") between autosaves of the 
current region in Apollo serial format. This can (theoretically) 
be used to retrieve your session if Apollo or your machine 
crashes. Set this to "none" to turn off autosaving.

DataAdapterInstall

These are the different file types and data sources that Apollo 
recognizes. The first argument is the name of the java class that 
will be used to read from the data source. The second is the 
style file associated with that datasource. (Note that some data 
adapters may have more than one style file, customized for 
different organisms. See the description SpeciesToStyle 
parameter.) 
The third (optional) argument to DataAdapterInstall overrides 
the label used to identify the data adapter in the pulldown list 
that is presented when you launch Apollo or Open a new 
dataset. 

BrowserProgram

The name of the program you use to look at Web pages. In 
general, you shouldn't need to change this. If you are on 
Windows or Mac, Apollo should figure out how to launch your 
Web browser. If you are on Linux, it assumes you have 
Mozilla; for other Unix systems, it assumes Netscape.

If you are having problems getting Apollo to launch your web 
browser, try setting BrowserProgram to the full path (e.g. 
/opt/local/netscape7). See the section on web browsers for 
more info.
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AskConfirmOverwrite

If the file you choose for saving your data already exists, 
Apollo will pop up a dialog box asking you if you really want 
to overwrite the file. If you prefer not to be asked this question, 
you can set AskConfirmOverwrite to false (default is true). 

SiteShowLimit
How many bases per pixel have to be displayed before the start 
and stop codons are displayed. If this is set to zero, no 
start/stop codons will be shown.

FastDrawLimit
Maximum number of features per pixel before features are 
merged together on the display to speed up drawing. If you set 
this above one things get a little odd.

TextAvoidLimit

When labels are switched on, if there are greater than this 
number of bases per pixel some labels may overlap each other. 
If the bases per pixel is less than this value, then the features 
and their labels are rearranged so nothing overlaps and all the 
labels can be read. You may be able to set this value higher 
depending on the speed of your machine and the speed of your 
JVM.

FrameOrientation The orientation (horizontal or vertical) used for the feature 
detail panel. Defaults to horizontal.

MainWindowWidth
Initial width (in pixels) of main Apollo window (default is 
1000). If you set it too big, window will automatically be 
limited to the size of your screen. 

Karyotypes Karyotypes file, used for synteny view.

OutputTransactionXML
Whether to save transactions in an Apollo .tnxml file. Set this 
to true if you'd like to see these (mostly useful for developers, 
and for tracking deletions). 

OutputChadoTransaction
Whether to save transactions in a Chado transaction file. Set 
this to true if you'd like to see these (mostly useful for 
developers). 

CommandLineXmlFileFormat
Default format to assume for XML files loaded from the 
command line without a --inputFormat parameter. (Default is 
game; can set to "chado".) 

SpeciesToStyle

Some data adapters (e.g. GAME XML adapter) are used to 
load data from different species. This parameter lets you 
specify a style file corresponding to a species, e.g., "Oryza 
sativa -> rice.style". 

Here are the parameters that can be specified in a style file: 

Parameter Explanation

Types

The location of the tiers file (usually called 
stylename.tiers) describing how to display the different 
feature types, including their order and colors. Expected 
to be in either the user's ~/.apollo directory or in 
Apollo's conf directory, along with the style files and 
apollo.cfg.

NameAdapterInstall This is the class of the name adapter to use if the 
name_method lines are missing from the tiers file (that 
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is where they are supposed to be specified now). 
Specified here in case you have an old tiers file that 
doesn't include name_methods. Current options are 
apollo.config.FlyNameAdapter and 
apollo.config.DefaultNameAdapter. (This parameter 
shouldn't be needed anymore--it's moved to the tiers 
file.) 

OverlapDefinition
Like name_method, this is now generally set in the tiers 
file by overlap_method. Current options are 
apollo.config.ORF_Overlap and SimpleOverlap. 

DisplayPreferences

Name of class that has project-specific methods for 
naming features. Currently available options are 
apollo.config.DefaultDisplayPrefs (the default) and 
apollo.config.FlyDisplayPrefs (for Drosophila data). 

ShowAnnotations Whether to show the curated annotations in a separate 
area. (Ensembl doesn't have these.) Default is true. 

Organism
Default organism for this style (to be used when writing 
out data, especially in Chado XML format, for features 
that don't have an organism attribute). 

ShowResults Whether to show the raw computational results.

EnableEditing

If this option is turned on, it allows you to curate your 
own annotations.
Please note that this works for GAME XML data, but 
GFF is not structured enough to permit annotation 
curation. 

EnableNavigationManager
Whether to show the navigation bar across the top of the 
main window--lets you go directly to the chromosome 
region you want.

Chromosomes
A list of valid chromosomes (or chromosome arms) for 
this organism. If this is left out, the chromosome 
pulldown menu will simply be replaced by a text box.

AnnotationBackgroundColor
Background color for the annotation panel. Colors can 
be a default Java color name (e.g. "white" or "red") or 
an RGB triplet (e.g. "127,255,0").

FeatureBackgroundColor Background color for the results panel.

CoordBackgroundColor Background color for the axis and the GC plot.

CoordForegroundColor The foreground color for the axis.

UserTranscriptColouring
Whether to color annotations by creator (default is 
false--all annotations are shown in the same color, as set 
in tiers file).

EdgematchColor
When a feature is selected all other features that have 
the same boundaries are highlighted at their edges. This 
defines the color they are highlighted in.

EdgematchWidth The width in pixels of the highlights that mark the 
matching edges. Default is 3.

AnnotationLabelColor The color that is used to label annotations.
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FeatureLabelColor The color that is used to label features when you turn on 
labeling.

SelectionColor When features are selected they are outlined to make 
them noticeable. This is the color used for the outline.

EvidencePanelHeight
Height (in pixels) of the evidence panel below the main 
Apollo display. Default is 200. Sensible values are 
between 150 and 350.

DashSets

Whether to use a dashed line to show sequence gaps in 
ESTs. (Color of dashed line is controlled by 
SequenceGapColor.) Default is false, but this is set to 
true in game.style.

SequenceGapColor Color to use for showing dashed-line gaps in ESTs.

Draw3D
Whether to show feature rectangles in 3D (default is 
false). Generally, programmers think the 3D effect is 
cool and biologists find it annoying.

DrawOutline Whether to outline feature rectangles in the edgematch 
color (default is false).

ExternalRefURL The URL used to fetch gene report Web pages.

DatabaseList

List of databases that will be offered to the user in a 
pulldown list when they load data. Will go into various 
data retrieval URLs (GeneURL, etc.) in place of the 
%DATABASE% field. (See fly.style for examples.)

DatabaseToStyle
Each database from the DatabaseList can optionally be 
mapped to a different style file (which may also point to 
a different tiers file) with this parameter

AnnotationComment
A canned comment that can be added to an annotation. 
You can have as many of these as you want, one to a 
line.

TranscriptComment
A canned comment that can be added to a transcript. 
You can have as many of these as you want, one to a 
line.

UserInfo

If UserTranscriptColoring is turned on, each user's 
annotations will be shown in their user color. Each line 
should include a username, project, and color, plus and 
optional full name.

PeptideStatus

This is complex because there is more than one thing 
that needs to be passed into the software. The first field 
is the precedence. The second field is the font which in 
turn is composed of 3 fields: fontname,fontstyle,fontsize 
(9 is the default). fontstyle can be 0,1,2,3 (plain, bold, 
italic, bolditalic). The third field indicates whether or 
not it is something that a curator may assert. The fourth 
field is the string for menus. Since part of this is coming 
from a program (SonOfSam), it needs to be coordinated 
with that as well and let us hope that the : (colon) is 
never used in the text because that would mess up the 
parsing.

DefaultFeatureLabelFont Fonts are composed of 3 comma-delimited fields: 
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fontname,fontstyle,fontsize (10 is the default).
fontstyle can be 0,1,2,3 (plain, bold, italic, bolditalic) 
DefaultFeatureLabelFont is used for annotations with 
unknown PeptideStatus (e.g. pseudogenes) as well as 
feature labels. The PeptideStatus annotation fonts are 
used for the label of the annotation as well as the font in 
the the gene menu. 

DefaultFont Axis numbers use the default font, and it's also used for 
residues inside features when you zoom in. 

ExonDetailEditorSequenceFont Used to show sequence residues in the Exon Detail 
Editor. 

ExonDetailEditorBackgroundColor1, 
2

Colors for the two alternating background stripes in the 
EDE 

ExonDetailEditorFeatureColor1, 2 Alternating colors for exons in the EDE 

ResultTag
Comments that can be attached to results of the 
specified type(s). See the section on tagging a result 
with a comment for more information. 

FeatureLoadSize

The maximum size of region that features can be 
fetched (default 1Mb). This is valid only for the 
Ensembl/Otter method of fetching to limit the amount of 
network traffic and reduce the load time. For regions 
greater than this size only genes and contigs are 
retrieved. 

GeneticCode

Most organisms use genetic code "1" (which is the 
default); the only other genetic code available at the 
moment is paramecium, which uses "6" (this is defined 
in paramecium.style). 

Debug Whether to print lots of debugging messages (useful for 
developers). Default is false. 

Tiers file

Each style has an associated tiers file, which contains details on how to display each type of 
data. A tier is a conceptual grouping of one or more types, which are displayed together in one 
row. The style file (e.g. fly.style) specifies the name of this configuration file (e.g. fly.tiers). 
Normally you shouldn't need to change that. The tiers file format is as follows. 

A tier record defines a set of feature types that will always be displayed together as a group. 
They will be displayed in the same row if possible when the features are expanded but as 
close together as possible if they overlap. 

A Tier record looks like this: 

[Tier]
tiername : Annotation
visible : true
expanded : true
maxrows : 0
labeled : true
curated : true
warnonedit: false
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The Tier fields (which can appear in any order, after the initial [Tier] line) and their default 
values are as follows: 

• label : false (Group tier label)
• visible : true
• expanded : false
• sorted : false
• maxrows : maximum number of rows to show for this tier--default 0 means all
• labeled : false (whether features of this type show up with labels if tier is expanded 

(labels are not shown in collapsed state))
• curated : false (whether features of this type belong in the annotation panel, rather than 

the results panel). For reverse-compatibility with older tiers files, this parameter is 
assumed to be true for the "Annotation" tier, but no others. This parameter was 
introduced to permit more than one annotation tier (with arbitrary names).

• warnonedit : false (whether to warn user if they try to edit annotations in this tier. Can 
also appear in an individual Type record.) 

Following a tier record is one or more Type records that specify the different types that should 
appear in that tier. A Type record starts with the line 

[Type]
and is followed by type fields, in any order. For example: 
[Type]
tiername : Gene Prediction
typename : Genscan
resulttype : genscan:dummy
resulttype : genscan
color : 204,153,255
usescore : true
minscore : -1
maxscore : 50
glyph : DrawableResultFeatureSet
column : SCORE 
column : GENOMIC_RANGE 
column : query_frame
sortbycolumn : GENOMIC_RANGE
weburl : http://genes.mit.edu/GENSCAN.html#
The recognized type fields are as follows (most are optional). 

tiername the tier this type appears in (required)

typename label for this type (required)

resulttype

data types that are included in this type (required). These are determined by 
the names that are used to identify data types in the input. For the 
Drosophila data, these names look like "sim4:na_gadfly.dros" or 
"blastx_masked:aa_SP.real.dros".

color
the color for this type can be a standard color name (e.g. red) or an R,G,B 
triplet (where each number can be between 0 and 255). The default color, if 
unspecified, is a pale yellow.

utr_color

color used for untranslated regions (UTRs). Only works with 
DrawableGeneFeatureSet. The default is black. If you'd like the UTRs to 
appear "transparent", set utr_color to the same color defined in the style file 
as AnnotationBackgroundColor.

usescore Whether to use the score to scale the height of this type (default is true)

minscore Minimum score for scaling height (default is 0)

maxscore Maximum score for scaling height (default is 100)
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glyph

Name of the glyph to use for displaying this type (required).
Current choices include DrawableGeneFeatureSet (exons connected by 
peaked introns), DrawableResultFeatureSet (exons connected by straight 
lines), DoubleHeadedArrow, Triangle, Zigzag, ThinRectangle (a 
rectangular outline).

column

name(s) of column(s) to be shown in detail table for this type.
Choices include GENOMIC_RANGE, GENOMIC_LENGTH, 
MATCH_RANGE, MATCH_LENGTH, SCORE, NAME, READS. You 
can also specify column names not in all caps that correspond to properties 
of the features present in the data (e.g. query_frame). 

sortbycolumn Row order in table is determined by this column.

reversesort Sort table rows in reverse order? (default false)

groupby

GENE method to use for grouping features (GENE, SINGLE, 
HOMOLOGY)
SINGLE is used for feature types that aren't grouped together (e.g. CPG 
islands). HOMOLOGY is used for feature pairs that need to be grouped 
together by hit ID. Features that are identified as HOMOLOGY (e.g. any 
blast hit or similarity search result) have a start and end coordinate on the 
hit sequence as well as on the genomic GENE is used for genes that need to 
be grouped together by ID. 

weburl

URL for pulling up web pages about this type of result, e.g. 
"http://www.ebi.ac.uk/cgi-bin/emblfetch?" or 
"http://www.ensembl.org/perl/geneview?gene=ID." 
Only one web site can be specified. The first example on the left is the 
simplest way to link out. If the name of the feature is AC005663 then your 
browser will be directed to http://www.ebi.ac.uk/cgi-bin/emblfetch?
AC005663--i.e., the name of the feature is tacked onto the end of the URL. 
More complicated URLs can be constructed. In the second example we 
only want the feature name up to the first "." For example, the gene name is 
QZ9839.1 and our web site only wants QA9839. The string ID. tells Apollo 
to truncate the name at the first ".". 
Because Apollo appends the feature ID to the end of the generic URL, you 
have to do a special trick for URLs that are not specific to individual 
results. For example, all the GENSCAN results point to the main 
GENSCAN web page, http://genes.mit.edu/GENSCAN.html. In order to 
avoid having that URL broken when individual GENSCAN result IDs are 
appended to it, you can add a # at the end: 
http://genes.mit.edu/GENSCAN.html#. Appending junk after the # will 
have no effect on the destination, so all the GENSCAN results will be 
appropriately directed to the same GENSCAN page.

freshdate

Date after which sequences of this type are considered "new" (the dates are 
found in the sequence descriptions).
The format of the freshdate can be 08-JUN-1999 or Wed May 15 00:00:00 
PDT 2002. The freshdate is compared to the date found in the header lines 
of sequences that have hits in the data file. For Drosophila data, the 
expected format of the header lines is 
gi||gb|AB003910|AB003910 Fruitfly DNA for 88F actin, complete cds. (08-
JUN-1999) 
where the date is formatted as DD-MMM-YYYY. The results that represent 
hits to new sequences will be boxed in the display. 

idformat format of IDs for this kind of annotation (e.g., CG\d+ means the ID must 
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start with the letters CG and end with one or more digits).

annot_type When this result is promoted to an annotation, annot_type says which type 
of annotation it should become.

overlap_method
Method used to decide whether two transcripts overlap. Current options are 
SimpleOverlap and ORF_Overlap.
If not specified, uses the class defined in the style as OverlapDefinition. 

name_method
Method used for naming features. Current options are DefaultNameAdapter 
and FlyNameAdapter.
If not specified, uses the class defined in the style as NameAdapterInstall. 

warnonedit (only relevant to annotations, not to results) Whether to warn user if they 
try to edit annotations of this type. Can also appear at the Tier level. 

number_of_levels

(only relevant to annotations, not to results) Traditional gene annotations 
are three-level: an annotation has transcripts which has exons. Recently, 
Apollo started offering support for one-level annotations such as point 
mutations and enhancers. Apollo now assumes that all annotation types are 
one-level EXCEPT for genes and pseudogenes, which are assumed (unless 
otherwise declared in the tiers file) to be three-level. You can explicitly set 
the number of levels (1 or 3) for a type with a line like "number_of_levels: 
3". 

Saving your type preferences

If you do File->Save type preferences... and save a new version of the tiers file, make sure the 
style file contains the new tiers file name. For example, if you saved a new Drosophila types 
file as "my.tiers", then you'd need to change the Types line in fly.style to say 
Types         "my.tiers"
If you save to the suggested file name (e.g. ~/.apollo/fly.tiers), you shouldn't need to change 
your style file--the new tiers file will be used automatically the next time you start Apollo. 

If you edit the tiers file manually, be aware that each tier line and each type line must be a 
single line--if these lines contain newlines, they will not be parsed properly. 

Getting the source code

You can download the latest Apollo source code from SourceForge. Each major release 
includes a tarfile of the SourceForge. If you are going to be actively involved in changing the 
Apollo code, though, you are better off getting the up-to-the-minute code from SourceForge 
CVS. 

Here is the command you can use for checking out the whole Apollo distribution from 
sourceforge: 

setenv CVS_RSH ssh
cvs -z3 -d:ext:myaccount@gmod.cvs.sourceforge.net:/cvsroot/gmod checkout -d 
apollo apollo
For "myaccount", substitute your own SourceForge account name. (It's a good idea to get a 
SourceForge account if you're going to be doing this--it's quick, free, and they don't send you 
spam.) If you don't want to get an account on SourceForge, you can do an anonymous 
checkout; however, anonymous checkouts give you a version that's a few days out of date. To 
check out an anonymous version: 
cvs -d:pserver:anonymous@gmod.cvs.sourceforge.net:/cvsroot/gmod login
cvs -d:pserver:anonymous@gmod.cvs.sourceforge.net:/cvsroot/gmod checkout -d 
apollo apollo
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The "-d apollo" specifies the directory name you want the Apollo stuff to go in, so you can 
change that if you want to put it somewhere else. 

After you've checked out the code, compiling it is straightforward: 

cd apollo
setenv APOLLO_ROOT `pwd`
cd src/java
make clean  [only necessary if you've already compiled and then updated]
make jar
You can also use Ant (available free from http://ant.apache.org/) to compile the source. It runs 
faster than make and is also easier to use if you're working on a Windows platform. 

To run your newly compiled apollo say: 

~/apollo/bin/apollo
(where ~/apollo is the directory where you've installed apollo--change as appropriate). You 
won't be able to run "Apollo" (with a capital A) like you may have done if you used the 
installed version of Apollo. 

Note that all these instructions assume that you're on a Unix-y system. If you're on Windows 
and you've already installed Apollo, you can stick your new apollo.jar in place of the old one. 

Adapting Apollo

An increasing number of groups are adapting Apollo in order to make it better fit their needs 
for genomic annotation editing. Changes to Apollo range from adding new data types to the 
tiers file, all the way to writing new data adapters and new gui components. 

If you are interested in modifying Apollo, you will undoubtedly already have downloaded the 
source code (see previous section). Although Apollo has extensive user documentation, the 
documentation for developers is more spotty. Assuming you have the source checked out, you 
can look at the javadocs (make javadoc), which are sparse but might still be helpful. If you are 
interested in data adapters, look at the data adapter "cookbook" 
(doc/html/dataadapter_cookbook.html). The Genome Biology paper about Apollo has a 
diagram and discussion of the Apollo architecture. You can also look at the doc/README 
files for assorted pieces of Apollo information. 

A note to developers about parameters in the style files: as of v1.6.3, you can add arbitrary 
(key=value) parameters to the style files and Style.java will record them as generic 
parameters. However, it is still up to the caller to ask for them by name (e.g. 
Config.getStyle().getParameter("typeIDOntology")) and to supply appropriate default values 
(because these generic parameters will have empty defaults). 

Customizing the Chado JDBC adapter

If you want to access your own Chado database, you will need to add or change text in the file 
conf/chado-adapter.xml in order to fill in the chadodb element. Here is an example: 

<!-- Indiana public FlyBase server r3.2 -->
<chadodb>
  <name>FlyBase Chado Indiana public server r3.2</name>
  <adapter>apollo.dataadapter.chado.jdbc.PostgresChadoAdapter</adapter>
  <url>jdbc:postgresql://bugbane.bio.indiana.edu:7302/chado_r3.2</url><dbNa
me>chado_r3.2</dbName>
  <dbUser>flybase</dbUser>
  <dbInstance>flybaseInstance</dbInstance>
  <style>fly.style</style>
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  <sequenceTypes>
    <type>gene</type>
    <type>golden_path_region</type>
  </sequenceTypes>
</chadodb>
Add a similar entry to chado-adapter.xml describing your Chado database. 

• name is the label that will appear in the dropdown list of databases. 
• adapter identifies the Apollo class to use for your database. If your database uses 

Postgres, use apollo.dataadapter.chado.jdbc.PostgresChadoAdapter; if you are using 
Sybase use apollo.dataadapter.chado.jdbc.SybaseChadoAdapter. If you are using a 
different database vendor, try Postgres and Sybase to see if one of them works; if they 
do not, please contact the Apollo mailing list. 

• url is the URL for your database server. 
• dbName is the database name to use on your server. 
• dbUser is the database user/login. 
• dbInstance identifies the type of Chado database (see step 3 below). 
• style is the style configuration file for this database (see Support Protocol 2). 
• sequenceTypes are the database fields corresponding to top-level entries. Each top-

level controlled vocabulary term is listed as a Type. 

You will also need to add or change text in the file conf/chado-adapter.xml to fill in the 
chadoInstance element. chadoInstance captures several things: a Java class to use, which 
controlled vocabularies to use, gene prediction programs, search hit programs, and a list of 
annotation types in your Chado database. Here is an example: 

<chadoInstanceid="flybaseInstance">
  <clsName>apollo.dataadapter.chado.jdbc.FlybaseChadoInstance</clsNam>

  <featureCV>SO</featureCV>
  <relationshipCV>relationship type</relationshipCV> 
  <propertyTypeCV>property type</propertyTypeCV>

  <genePredictionPrograms> 
    <program>genscan</program> 
    <program>piecegenie</program> 
  </genePredictionPrograms>

  <searchHitPrograms>
    <program>
      <name>blat</name>
      <source>cDNA</source>
      <version>1.3</version>
    </program>
    <program>sim4</program>
    <program>%blastx%</program>
  </searchHitPrograms>        
  <searchHitsHaveFeatLocs>false</searchHitsHaveFeatLocs>

  <oneLevelAnnotTypes>
    <type>promoter</type>
    <type>insertion site</type>     
    <type>transposable_element</type>
    <type>remark</type>
    <type>repeat_region</type>      
    <type>substitution</type>
    <type>nucleotide_deletion</type>
    <type>nucletide_insertion</type>
  </oneLevelAnnotTypes>

  <threeLevelAnnotTypes>
    <type>gene</type>
    <type>pseudogene</type>
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    <type>tRNA</type>
    <type>rRNA</type>
    <type>miRNA</type>
  </threeLevelAnnotTypes>

</chadoInstance>
clsName is the class name to be used for your Chado instance. There are currently three 
Chado instance classes: 

• apollo.dataadapter.chado.jdbc.TigrSybilChadoInstance
• apollo.dataadapter.chado.jdbc.FlybaseChadoInstance
• apollo.dataadapter.chado.jdbc.RiceInstance

RiceInstance is the most up-to-date of the three, so start by trying that with your database; if it 
does not work, please contact the Apollo mailing list. 

featureCV, relationshipCV, and propertyTypeCV are the names of controlled vocabularies in 
chado (these tend to vary in different chado instantiations. 

<program> can be defined in two ways:

• <program>program_name</program>
• <program>

  <name>program_name</name>
  <source>data_source</source>
  <version<data_version</version>
</program>

The second format can be used for filtering which data source/version to retrieve from the 
database (useful for viewing and dumping only a subset of all the data). The <version> 
element is optional. 

genePredictionPrograms is a list of gene prediction programs to query for. 

search hit programs is a list of similarity search programs to query for. 

Search hits (parent feature sets, not hsp leaves) may or may not have feature locs associated 
with them in chado (rice has them, fly does not). If there are search hit feat locs, the jdbc 
adapter will retrieve out of range hsp/leaves that are associated with in range hits, otherwise it 
doesn't. 

oneLevelAnnotTypes and threeLevelAnnotTypes list annotation types consisting of one and 
three levels. (Eventually this will be determined automatically.) One level annot types 
substitution, nucletide_insertion, and nucletide_deletion are treated special by apollo (though 
they are not by chado). These do not show up as features in the main window, rather they 
show up as sequence errors in the exon detail editor, with a base pair turned orange. The main 
window just displays an orange vertical line for these. 

Select your database from the pull-down menu next to Chado Database. Then select a region 
to display. The list for Type of Region includes the sequenceTypes listed in chado-
adapter.xml that correspond to the top-level types in your Chado database. For example, you 
may query the FlyBase Chado database by gene or by golden_path_region, a 250-350kb 
region of genomic sequence. Enter the identifier for the Type next to Region ID and click OK. 
Be patient; large regions may take time to retrieve. 

More resources for the developer

101



The data adapter "cookbook" (doc/html/dataadapter_cookbook.html) has some useful 
information. Also see doc/random_developer_notes.txt and the Apollo FAQ. 

The Apollo mailing list is your best resource for asking questions about Apollo. 

Contributed Apollo Documentation

DNA Learning Center at Gramene

There is a series of Quicktime recordings about using Apollo at Gramene. 
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4. Annex  

4.1. M. incognita genome: Abad et al. 2008.

Genome sequence of the metazoan plant-parasitic nematode Meloidogyne incognita

Abstract

Plant-parasitic  nematodes  are  major  agricultural  pests  worldwide and novel  approaches  to 
control  them  are  sorely  needed.  We  report  the  draft  genome  sequence  of  the  root-knot 
nematode  Meloidogyne  incognita,  a  biotrophic  parasite  of  many crops,  including  tomato, 
cotton and coffee. Most of the assembled sequence of this asexually reproducing nematode, 
totaling  86 Mb, exists  in pairs  of homologous but divergent  segments.  This suggests  that 
ancient allelic regions in M. incognita are evolving toward effective haploidy, permitting new 
mechanisms of adaptation. The number and diversity of plant cell wall–degrading enzymes in 
M. incognita is unprecedented in any animal for which a genome sequence is available, and 
may derive from multiple horizontal gene transfers from bacterial sources. Our results provide 
insights  into  the  adaptations  required  by  metazoans  to  successfully  parasitize 
immunocompetent plants, and open the way for discovering new antiparasitic strategies.

 4.2. Practical: Fragoso et al. 2008.

Meloidogyne incognita: Molecular cloning and characterization of a cDNA encoding a 
cathepsin D-like aspartic proteinase. 

Abstract

Herein  we  describe  the  cloning  and  characterization  of  a  cDNA  encoding  an  aspartic 
proteinase  from the root-knot nematode  Meloidogyne  incognita.  Using PCR techniques,  a 
1471-bp cDNA fragment encoding a cathepsin D-like (Mi-asp1) transcript was isolated from 
second-stage larvae mRNA. Its predicted amino acid sequence comprises a pro-region of 71 
amino  acid  residues  and a  mature  protease  of  378 amino  acid  residues  with  a  predicted 
molecular mass of 41.502kDa. Protein sequence comparisons of Mi-asp1 with GenBanktrade 
mark (DQ360827) sequences showed 59-71% identity with nematode-specific cathepsin D-
like  aspartic  proteinases.  Southern  blot  analysis,  RT-PCR amplification  and  EST  mining 
suggest  the  existence  of  a  developmentally  expressed  gene  family  encoding  aspartic 
proteinases  in  M.  incognita.  Mi-asp1 may  represent  a  potential  target  for  molecular 
intervention for the purposes of plant-parasitic nematode control.
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